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Introduction

Welcome to the Bose ControlSpace Designer software user guide. 
ControlSpace Designer software allows you to design and configure the 
signal processing and controls for an engineered sound system. 
ControlSpace Designer software, along with the ESP-88 Engineered 
Sound Processor, the CC-64 Control Center, and the CC-16 Zone 
Controller, provides a powerful, and flexible DSP solution for nearly any 
installation. This user guide covers the following topics:

• Chapter 1: Configure the ControlSpace Designer network
• Chapter 2: The ControlSpace Designer software interface
• Chapter 3: Build a ControlSpace ESP-88 system
• Chapter 4: Store system programming
• Chapter 5: Program user controls: CC-64 and CC-16
• Chapter 6: Program GPI/O and Serial Input/Output
• Chapter 7: Signal Processing (SP) Tool Kit reference
• Chapter 8: Menu and Toolbar reference 

System Requirements
• Microsoft® Windows® XP Professional, Service Pack 2 (or later)

• Microsoft® .NET™ Framework version 1.1

• Intel® Pentium® 4 850Mhz processor (or better)
• 512 MB RAM
• 100 MB disk space available
• CD-ROM Drive
• 1024x768 32 bit XGA color video display adapter

Install ControlSpace Designer software
Follow these steps to install ControlSpace Designer software:

1.  Insert the ControlSpace Designer installation CD into the CD-
ROM drive in your computer.

2.  Open Windows Explorer and navigate to the CD directory.
Introduction                                                               i
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3.  Double-click on Setup.exe to install ControlSpace Designer 
software.

Figure 1 - Installer window

4.  Click Next to begin installation.

5.  Follow the prompts to install ControlSpace Designer software 
onto your computer.

6.  After installation, specify whether you would like to create desktop 
or quick launch icons.

Note: You must have Microsoft® .NET™ Framework 1.1 installed on your 
computer to run ControlSpace Designer software.
ii                                                                     Introduction
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Figure 2 - Desktop and quick launch icons

Place a check mark to create one or both of these shortcuts.

       
Figure 3 - Quick launch and desktop shortcuts
Introduction                                                               iii
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7.  Click Finish when installation is complete

Figure 4 - Final installer screen

Launch ControlSpace Designer software
Follow these steps to launch ControlSpace Designer software:
Go to Start > All Programs > Bose > ControlSpace Designer to launch 
ControlSpace Designer software, or click the ControlSpace Designer 
software quick launch icon in the taskbar.
iv                                                                     Introduction
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Chapter 1: Configure the ControlSpace Designer 
network

This chapter covers how to configure the network connections to 
establish your ControlSpace Designer network, and how to update the 
firmware for the ESP-88, CC-64, and CC-16. A ControlSpace ESP-88 
system always includes at least one ESP-88 Engineered Sound 
Processor, and may include one or more CC-64 Control Centers, and CC-
16 Zone Controllers. You will need a computer running ControlSpace 
Designer software to connect to and configure the ControlSpace Designer 
network.

Ethernet connections
The method of communication between the ESP-88, CC-64, and your 
computer is 10Base-T Ethernet. You can connect your computer directly 
to a single ESP-88, or you can set up a network between your computer, 
the ESP-88 and the CC-64 using an Ethernet hub. 

Connect to one ESP-88
To connect your computer directly to a single ESP-88, use the included 
Ethernet crossover cable to connect the Ethernet port on your computer 
to the LAN port on the back of the ESP-88. This crossover cable is only 
used when connecting your computer directly to the ESP-88, without 
using an Ethernet hub. The crossover cable has a “crossover” label near 
the connector end. You should see the Ethernet LED on the front panel of 
the ESP-88 turn green. If it does not, check to make sure your cable 
connections are secure, and that you are using a crossover type cable.

Connect to multiple ESP-88s and CC-64s using an Ether-
net hub
To connect your computer to two or more ESP-88s, or to an ESP-88 and 
one or more CC-64s, you will need to use an Ethernet hub. The hub can 
be either a switch or repeater-type hub. Using standard straight-through 
CAT-5 cables, connect your computer, ESP-88s, and CC-64s to the 
Ethernet hub.

Tip: Some Ethernet hubs support Auto-MDX specifications, which 
allows the use of either crossover or straight-through cables.
   Chapter 1: Configure the ControlSpace Designer network                    1
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Change your computer’s network settings

Follow these steps to configure the TCP/IP network settings on your 
computer for the local network (the steps are shown in Windows XP):

1.  Go to Start > Control Panel.

2.  Open the Network Connections control panel.

Figure 1.1 - Network Connections control panel

3.  Right click on Local Area Connection and choose Properties.
2                                 Chapter 1: Configure the ControlSpace Designer network
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Figure 1.2 - Choose Local Area Connection Properties

The Local Area Connection Properties window opens:

Figure 1.3 - Local Area Connection Properties window
   Chapter 1: Configure the ControlSpace Designer network                    3
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4.  Select Internet Protocol (TCP/IP) and press the Properties 
button.

The Internet Protocol (TCP/IP) Properties window opens.

Figure 1.4 - TCP/IP Properties window

5.  Click on the Use the following IP address button to specify an 
IP address for your network adapter. In the IP address field, type 
in the following IP address: 192.168.0.88
4                                 Chapter 1: Configure the ControlSpace Designer network



Bose® ControlSpace™ Designer™ Software User Guide
Figure 1.5 - Type in the IP address

Note: We recommend using the IP address  192.168.0.88  for your 
computer to avoid conflicts with other network devices such as 
Ethernet routers. Do not use 192.168.0.160 through .255 for your 
computer’s IP address as these addresses are reserved for 
ControlSpace devices.
   Chapter 1: Configure the ControlSpace Designer network                    5
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6.  After entering the IP address, press the Tab key, and the Subnet 
mask is automatically filled in:

Figure 1.6 - Subnet mask is filled in

7.  Press OK in the TCP/IP Properties window, then press OK again 
in the Local Area Connection Properties window to effect the 
change to your network settings.
6                                 Chapter 1: Configure the ControlSpace Designer network
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Figure 1.7 - Press OK in both windows to effect changes

Note: You must press OK in both the TCP/IP Properties window AND the 
Local Area Connection Properties window to effect your IP address 
change.

If you are using at most one ESP-88 and one CC-64, you can now plug 
the ControlSpace hardware devices and your computer into the Ethernet 
hub to create your local network. If you are using more than one ESP-88 
or more than one CC-64, you must properly set the hardware IP 
addresses before plugging all the ControlSpace hardware devices into 
the Ethernet hub to prevent a conflict. See Using more than one ESP-88 
in the next section for more information.

IP addresses
ControlSpace Designer software uses Internet Protocol (IP) addresses to 
identify the ESP-88s and CC-64s in your network. Each computer, ESP-
88 and CC-64 must have a unique IP address in your ControlSpace 
Designer network. 
   Chapter 1: Configure the ControlSpace Designer network                    7
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Use more than one ESP-88
Each ESP-88 is shipped with the IP address set to 192.168.0.160. If you 
are using more than one ESP-88 you will need to change the IP address 
of the additional ESP-88s to avoid a conflict (for example, to 
192.168.0.161). Follow these steps to set IP addresses when connecting 
multiple ESP-88s to your local network:

1.  Connect the first ESP-88 to the Ethernet hub.

2.  Launch ControlSpace Designer software and choose System > 
Network Setup to open the Network Setup window.

Figure 1.8 - Network Setup window

If your ESP-88 does not appear in the Network Setup window, 
check the cable connection and press the Scan button.

3.  Select the ESP-88 and press the Change to... button to change 
the IP address of the connected ESP-88. The Address setting 
window opens. Each ESP-88 must have a unique IP address in 
your local network. You must change the IP address of this first 
ESP-88 so there are no conflicts when you connect the next ESP-
88 (which also has a default IP address of 192.168.0.160).

Note: When using two ESP-88s, you must change the IP address of the 
first ESP-88 that you connect so that there are no conflicts when 
you connect the next ESP-88 (each ESP-88 is shipped with the 
same default IP address).
8                                 Chapter 1: Configure the ControlSpace Designer network
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Figure 1.9 - Change IP address in the Address setting window

Type 161 for the last three digits of the New IP Address, and 
press Change.

Figure 1.10 - Successful IP address change dialog

You will see a dialog indicating a successful IP address change. 
4.  Power cycle the ESP-88 for the setting to take effect.

5.  Connect the second ESP-88 to your Ethernet hub. This ESP-88 
has an IP address ending in 160, so it will not conflict with the first 
ESP-88 that you connected, which now has an IP address ending 
in 161.

Use more than one CC-64
Each CC-64 is shipped with the IP address set to 192.168.0.176. As with 
the ESP-88, if you are using more than one CC-64 you will need to 
change the IP address of the additional CC-64s to avoid a conflict (for 
example, to 192.168.0.177). Follow these steps to set IP addresses when 
connecting multiple CC-64s to your local network:

1.  Connect the first CC-64 to the Ethernet hub.
   Chapter 1: Configure the ControlSpace Designer network                    9
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2.  Launch ControlSpace Designer software and choose System > 
Network Setup to open the Network Setup window.

Figure 1.11 - Network Setup window

3.  Select the CC-64 and press the Change to... button to change 
the IP address of the connected CC-64. The Address setting 
window opens. Each CC-64 must have a unique IP address in 
your local network. You must change the IP address of this first 
CC-64 so there are no conflicts when you connect the next CC-64 
(which also has a default IP address of 192.168.0.176).

Note: When using two CC-64s, you must change the IP address of the 
first CC-64 that you connect so that there are no conflicts when you 
connect the next CC-64 (each CC-64 is shipped with the same 
default IP address).
10                                 Chapter 1: Configure the ControlSpace Designer network
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Figure 1.12 - Change IP address in the Address setting window

Type 177 for the last three digits of the New IP Address, and 
press Change.

Figure 1.13 - Successful IP address change dialog

You will see a dialog indicating a successful IP address change. 
4.  Press OK to reboot the CC-64.

5.  After reboot, connect the second CC-64 to your Ethernet hub. 
This CC-64 has an IP address ending in 176, so it will not conflict 
with the first CC-64 that you connected, which now has an IP 
address ending in 177.
   Chapter 1: Configure the ControlSpace Designer network                    11
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Use scan
The Scan button in ControlSpace Designer software can be used to 
detect hardware on your local network.

Figure 1.14 - Scan button

Note: You should open a new project before using the Scan button. If you 
press the Scan button with an existing project open, you may 
experience a conflict that could change your system design 
configuration. 

Do not press the Scan button while you have an existing project open. 
This may result in a conflict that can cause a change in your system 
design configuration. Scan should be used with a blank new project only, 
as a means to identify what hardware exists on the local network. When 
ControlSpace Designer software completes the scan, the Project View is 
automatically populated with the ESP-88s, CC-64s, and CC-16s that are 
properly connected in your local network.
12                                 Chapter 1: Configure the ControlSpace Designer network
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Figure 1.15 - After a scan, Project View shows the connected hardware

To view the IP address of an ESP-88 or CC-64, simply hold the mouse 
cursor over the icon in Project View.

Figure 1.16 - Hold the cursor over an icon to view the IP address
   Chapter 1: Configure the ControlSpace Designer network                    13
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Network setup
To view and change the IP address of a component on your system, 
choose System > Network Setup to open the Network Setup window.

Figure 1.17 - Network Setup window

The network is automatically scanned for all connected hardware. If you 
change your hardware configuration while the Network Setup window is 
open, press the Scan button to refresh the connected components list. 
Click on a device and press the Change to... button to change the IP 
address of that device. Each ESP-88 and CC-64 in your system must 
have a unique IP address. Use the following IP addresses for the ESP-88 
and CC-64:

•    ESP-88 - 192.168.0.160 through .175
•    CC- 64 - 192.168.0.176 through .207

Note: You must use IP addresses within the above ranges, or the 
hardware device will not be found on the network.

Device firmware
The ESP-88, CC-64, and CC-16 require firmware to control their 
operation. Firmware is programming that is stored in Flash memory and is 
not erased when the power is turned off. On occasion, it is necessary to 
update this firmware to fix problems or improve features. This section 
describes how to update the firmware using ControlSpace Designer 
software.
14                                 Chapter 1: Configure the ControlSpace Designer network
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Update firmware
To update firmware, you will first need to get the new firmware file. Follow 
these steps to update the firmware:

1.  The latest firmware files can be downloaded at http://
pro.bose.com.

Firmware for the ESP-88 is a .frm file.
Firmware for the CC-64 is a .mot file.
Firmware for the CC-16 is a .hex file.

2.  Place the new firmware file into the bin folder within the 
ControlSpace directory on your hard drive. If you installed 
ControlSpace into the default location, the address for the bin 
folder is C:\Program Files\Bose\ControlSpace\bin. 

3.  Launch ControlSpace Designer software and connect any ESP-
88s and CC-64s to the local network that your computer is 
connected to.

4.  In ControlSpace Designer software, go to System > Update 
Firmware.

The Firmware update window opens.
   Chapter 1: Configure the ControlSpace Designer network                    15
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This window lists all connected ESP-88s, CC-64s, and CC-16s. 
Press the Scan button to refresh the list. The new firmware 
version number (from the file in the bin folder) will show up in the 
Latest version column, and the current firmware version number 
is displayed in the Loaded version column. If your firmware is 
up-to-date, the loaded and latest versions will be the same, and 
the status will be “up-to-date.”

5.  Select the devices to update by placing a checkmark in the box 
next to the IP address. Press the Update button to load the new 
firmware.

6.  After updating is complete, click OK when you are prompted to 
reboot all devices.

Figure 1.18 - Reboot devices after firmware update
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After reboot, the Firmware Update window indicates that the 
update was successful.

Figure 1.19 - Successful firmware update

Note: If the ESP-88 does not appear in the Firmware Update window after 
the firmware update, try power cycling the ESP-88, then press the 
Scan button in the Firmware Update window.
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Chapter 2: The ControlSpace Designer Software 
Interface

This chapter serves as an introduction to the ControlSpace Designer 
software user interface. You will be introduced to the main windows in the 
software, along with some important features. 
To begin, launch ControlSpace Designer software by choosing Start > All 
Programs > Bose > ControlSpace Designer.

ControlSpace Designer software windows
The ControlSpace Designer software interface is shown in Figure 2.1:

Figure 2.1 - ControlSpace Designer software window
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Project View
The main window to the right is called Project View, and the smaller 
window to the left is the Device List.

• Project View is a workspace where you will build and connect the 
components of your sound system. 

• The Device List contains the individual sound system 
components, organized by type.

Create your system design by dragging and dropping individual 
components from the Device List into the Project View. For example, to 
connect a CD player to an input card in your ESP-88, follow these steps:

1.  Drag an ESP-88 icon from the Device List into the Project View.

Figure 2.2 - Drag an ESP-88 from the Device List into the Project View

2.  Open the Electronics tree in the Device List by clicking on the 
“+” next to Electronics.
20                                 Chapter 2: The ControlSpace Designer Software Interface



Bose® ControlSpace™ Designer™ Software User Guide
3.  Drag a CD player into the Project View.

Figure 2.3 - Drag a CD player into the Project View

4.  Next, you will wire these two components together. To place a 
wire, first hold the mouse cursor near the triangle output 
connection point on the CD player icon until it turns into a hand-
pointer:

Figure 2.4 - Hold the cursor over the output connection
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5.  Click and drag a wire from the top CD player output, to the top 
input of the ESP-88:

Figure 2.5 - Click and drag a wire from output to input.

ESP-88 window
Each time an ESP-88 is added in Project View, a new ESP tab is created 
for that device. Click on the ESP-88 tab next to the Project View tab to 
switch to the ESP-88 window.

Figure 2.6 - ESP-88 window

Note: You can also double-click on the ESP-88 in Project View to switch 
to the ESP-88 window.

The ESP-88 window is where you configure the signal processing for this 
ESP-88. Notice that the window on the left, which previously showed the 
Device List, has changed to show the Signal Processing Tool Kit (SP 
Tool Kit).
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Figure 2.7 - ESP-88 window

The Signal Processing Tool Kit (SP Tool Kit) on the left contains all the 
individual signal processing blocks (SP blocks) that you can use to build 
the signal processing for your design. Simply drag and drop these blocks 
into the ESP-88 window on the right to configure your system.

The ESP-88 window shows all the physical inputs and outputs to the 
ESP-88. The ESP-88 in Figure 2.7 has two input cards (in Slot 1 and Slot 
3) and two output cards (in Slot 2 and Slot 4) installed. At the top of the 
window are the General Purpose Inputs (GPI), General Purpose 
Outputs (GPO), and Serial input and Serial output control blocks.
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Input blocks

Double-click on the Slot1 In1 icon to open the control panel for this input. 

Figure 2.8 - Slot1 In1 control panel

You can use the control panel to adjust the input level, to turn on Phantom 
Power, or to mute the input.
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Signal Processing (SP) Tool Kit
The SP Tool Kit contains all available signal processing blocks (SP 
blocks). Select and drag a signal processing block from the SP Tool Kit 
window to the ESP-88 window to include it in your design. Wiring between 
inputs, outputs and signal processing blocks is done in the same manner 
as in Project View (see Figure 2.5). Double-click on any signal 
processing block to open the control panel. For example, if you wanted to 
mix four channels of audio to two output channels, your design might look 
like Figure 2.9 below:

Figure 2.9 - A simple design with the mixer control panel open
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Control Library windows
From the Window menu, you can open the Parameter Sets, Groups, 
Timers, and Presets windows. These windows can be thought of as a 
“Control Library” in ControlSpace Designer software. Use the Control 
Library to store programming that can be assigned to user control devices 
such as the CC-64 and CC-16. Programming is done through drag and 
drop. For example, to group together two inputs, go to Window > Groups 
to open the Groups window, then drag and drop the two input icons onto 
the Group 1 tree to create a group:

Figure 2.10 - Drag and drop two inputs to create a group

These two inputs will now be linked together. The windows in the Control 
Library will be covered in more detail in Chapter 4: Store system 
programming. 
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Smart Simulators
ControlSpace Designer software uses Smart Simulators to simplify 
programming and testing the controls for your ControlSpace ESP-88 
system. Switch to Project View by clicking on the Project View tab, and 
drag a CC-64 into the Project View window from the Device List:

Figure 2.11 - Drag a CC-64 into the Project View
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Double-click on the CC-64 to open the CC-64 Smart Simulator:

Figure 2.12 - The CC-64 Smart Simulator

The Smart Simulator window displays a graphical representation of the 
CC-64 in the top half, and a programming tree in the bottom half. Program 
the user controls by dragging and dropping signal processing blocks, 
parameter sets, or groups into the programming tree. You can then 
simulate the operation of the CC-64 using the knobs and buttons in the 
top half of the display.
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ControlSpace workflow
Now that you have been introduces to the basics of the ControlSpace 
Designer software interface, it will be helpful to know the basic process 
that you will follow to create a ControlSpace project in ControlSpace 
Designer software. While each ControlSpace project is different, the 
following steps represent a typical path from start to finish.

Step 1: Build and connect the components of your sys-
tem in the Project View
Drag and drop the main components of your system, including any CC-64 
and CC-16 controllers, from the Device List into Project View, and wire 
them together. This provides a graphical reference to the connections in 
your system. 

Figure 2.13 - Place and wire the components of the system
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Step 2: Configure the signal processing in the ESP-88
Switch to the ESP-88 window and drag and drop the necessary signal 
processing for your design, and wire the blocks together to define your 
signal flow.

Figure 2.14 - Add signal processing
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Step 3: Store the system programming
Create your Control Library, which includes presets, parameter sets, 
groups and timers needed in your system. Drag and drop signal 
processing blocks, inputs or outputs into the appropriate Control Library 
window to store the settings. (To create a preset, press the Store button 
in the Preset window.) For example, drag and drop two inputs into a 
group to create a master control for these two blocks.

Figure 2.15 - Drag and drop to store programming
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Step 4: Program user controls
The Control Library programming that you created in step 3 generally 
needs to be accessed by end users of the system. For example, the user 
may need to be able to switch between two parameter sets to select one 
of the two microphones. To program a CC-64 or CC-16 controller, drag 
and drop from the Control Library windows into the Smart Simulators. 

Figure 2.16 - Drag and drop into the Smart Simulator to program user controls, for example, 
program a CC-64 with a parameter set.
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Step 5: Go online
To transfer the system design to the hardware and begin working online, 
press the Go Online button, and upload the configuration. A blue 
background indicates that you are online. When the system is online, all 
signal processing settings can be accessed and modified, but changes to 
the wiring and signal flow are not allowed.

Figure 2.17 - On-line (blue background)

Note: To go on-line, you must be connected to the hardware via Ethernet, 
and have your IP address correctly configured for a local network.

Final Step: Disconnect
Press the Go off-line button before disconnecting your computer from the 
local network to properly deploy the ControlSpace ESP-88 system.

Figure 2.18 - Go off-line button
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Chapter 3: Build a ControlSpace ESP-88 system
This chapter covers how to build a sound system design in ControlSpace 
Designer software. 

Build a system design
The first step toward creating a ControlSpace ESP-88 system design in 
Designer software is to specify the hardware components that make up 
your system. 

Project files
Your system design is stored in a project file with the file extension .csp. 
When you launch ControlSpace Designer software, a new project is 
automatically created and named “Untitled”. When you first save the 
project, you will be prompted to rename it. 

Note: The system configuration that is stored in the ESP-88 can be 
downloaded to a project file at any time. This is helpful if you are 
working on a system that you did not create, or if you do not have 
the original .csp file. You can connect to the ESP-88 and download 
the configuration. See Downloading settings: connecting to an 
existing ControlSpace ESP-88 system at the end of this chapter.
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Project View
Project View is a workspace where you add and connect the hardware 
components in your system design. These components are dragged from 
the Device List on the left and dropped into Project View on the right.

Figure 3.1 - Drag and Drop devices into Project View

Project View allows you to graphically lay out the system design. The 
only required components are the ESP-88 and any CC-64s and CC-16s 
that are part of your design. Other devices, such as microphones and 
loudspeakers, can be added for your reference only, they do not perform 
any function in ControlSpace Designer software.

Note: You must wire any CC-16s in your design to an ESP-88 in Project 
View. All other wiring is technically optional, but can be added as a 
graphical reference.
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Any ESP-88, CC-64 and CC-16 in your design can be renamed. Select 
the icon and press F2, or right click and choose Rename.

Figure 3.2 - Renaming a CC-16

Tip: The first ESP-88 that you place acts as the Real Time Clock (RTC) 
for the system. This is indicated in the ESP-88 icon title bar. Go to 
Tools > Set Main ESP... to change which ESP-88 is the RTC in your 
design.

 

Devices are wired together by dragging and dropping wires from output 
nodes to input nodes, as shown in Figure 3.3.

Figure 3.3 - Click and drag a wire from output to input.
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To delete a wire, select the wire and press the Delete key, or right click 
and choose Delete.

Figure 3.4 - Delete a wire

To move a wire, select the wire by clicking anywhere on the wire, then 
click and drag the blue node to the new location.

Figure 3.5 - Drag the blue node to move a wire
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ESP-88 properties 

ESP-88 properties, including the input/output card configuration, can be 
accessed by right clicking on the ESP-88 in Project View, and choosing 
Properties....

Figure 3.6 - Setting the input/output card configuration for an ESP-88

The slots in the Audio Cards section correspond to the slots on the back 
of the ESP-88. Choose a card from the dropdown menu to change the 
slot configuration. When you are connected to the ESP-88, running a 
Scan will automatically set the ESP-88 card configuration to the hardware 
that you are using.

Note: The ESP-88 comes with 8 analog inputs (mic or line-level), and 8 
analog line level outputs. These cards occupy the first four slots in 
the ESP-88. You can expand the number of inputs and outputs by 
adding cards to the remaining 4 slots in the ESP-88. This allows you 
to use up to 16 more analog audio channels (any combination of 
input or output), or up to 32 more digital audio channels using 
AES3 cards.
        Chapter 3: Build a ControlSpace ESP-88 system                               39



Bose® ControlSpace™ Designer™ Software User Guide
Note: Available audio cards may differ from those shown in the Audio 
Cards dropdown menus.

You can also expand the functionality of the ESP-88 by installing an 
additional General Purpose Input/Output card, or the DSP expansion 
card. Specify the DSP card and GPI/O card configuration at the bottom of 
the Properties window.

Figure 3.7 - DSP and GPI/O card configurations

ESP-88 window
Signal processing is configured in the ESP-88 window. The ESP-88 
window is accessed by clicking on an ESP-88 tab at the top of the window 
or by double-clicking on an ESP-88 in Project View. If you have more 
than one ESP-88 in your design each will have a separate tab. The ESP-
88 window is a block diagram display of the processing inside the 
selected ESP-88 unit, including inputs, outputs, signal processing blocks, 
and the GPI/O and Serial Inputs/Outputs.

Figure 3.8 - ESP tabs
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Card inputs

The column of blocks to the left side of the window represent the card 
inputs on the ESP-88. The inputs are named by which slot they are 
physically located in, for example SLOT1, or SLOT3.

Figure 3.9 - Card inputs

To help organize your design, you can rename any signal processing, 
input, or output block by clicking on the block and pressing F2, or by right 
clicking and choosing Rename. 
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Figure 3.10 - Renaming a input blocks

When the ESP-88 is online and a signal is present at the input, the audio 
input indicator lights up green, yellow, or red. These lights represent the 
following levels:

•    Green - signal is greater than -36 dBu/-60 dBFS 

•    Yellow - signal is greater than or equal to +4 dBu/-20 
dBFS

•    Red - near clipping, signal is greater than or equal to +18 
dBu/-6 dBFS

These indicators are mirrored in the LEDs on the front panel of the ESP-
88.
Double-click on an input block to open the input control panel. Here you 
can adjust the input level, and set the input type and input gain. You can 
also turn on phantom power and mute the input.
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Figure 3.11 - 4X4 Mic/Line card input control panel

Tip: To copy the settings from one input to another, right click on the 
input block and choose Copy Parameters (or press Ctrl + G). Then 
paste the settings to other inputs by selecting one or more inputs, 
right clicking, and choosing Paste Parameters (or press Ctrl + R)

When an input is muted, the block output node turns red in the ESP-88 
window and in Project View:

Figure 3.12 - Muted input blocks
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Card Outputs

The column of blocks to the right side of the ESP-88 window represent 
the card outputs on the ESP-88. The outputs are named by which slot 
they are physically located in, for example SLOT2, or SLOT4.

Figure 3.13 - Output blocks

The output node on an output block cannot be wired to as it represents 
the hardware output of the audio signal. An output node has three 
different icons and two different colors, as shown in the following figures:

Figure 3.14 - Output is not connected

Figure 3.15 - Output is connected

Figure 3.16 - Output is connect and polarity is reversed
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Figure 3.17 - Output is muted

As with any block in the ESP-88 window, you can rename outputs by 
pressing F2, or by right clicking and choosing Rename. The output blocks 
also have audio level indicators, which display a green, yellow, or red light 
in the same manner as the input blocks.

•    Green - signal is greater than -36 dBu/-60 dBFS 

•    Yellow - signal is greater than or equal to +4 dBu/-20 
dBFS

•    Red - near clipping, signal is greater than or equal to +18 
dBu/-6 dBFS
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Double-click on an output block to open the output control panel. Use this 
control panel to adjust the output level. You can also change the polarity 
of the output signal, and mute the output.

Figure 3.18 - Output control panel

General Purpose Inputs (GPI) and General Purpose Outputs 
(GPO)

The blocks in the upper left corner of the ESP-88 window are used to 
program the General Purpose Inputs (GPI) and General Purpose Outputs 
(GPO). General purpose inputs to the ESP-88 allow you to control the 
system using devices such as switches and potentiometers. For example, 
a simple on/off switch could be used to switch between presets. General 
Purpose Outputs allow you to generate contact closure outputs from the 
ESP-88. See Chapter 6: Program GPI/O and Serial Input/Output for more 
information on programming General Purpose Inputs and Outputs.

Serial Inputs, Serial Outputs

The ESP-88 has a serial port that can be used to send or receive serial 
strings or commands.The blocks in the upper right corner of the ESP-88 
window are used to program the Serial Inputs (SerialInput) and Serial 
Outputs (SerialOutput). Serial inputs can be programmed to invoke an 
action in the ControlSpace ESP-88 system when a serial command is 
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received from an external device. Serial Outputs can be programmed to 
send a serial command to an external device when a parameter set is 
invoked, or when a timer expires. See Chapter 6: Program GPI/O and 
Serial Input/Output for more information on programming Serial Inputs 
and Serial Outputs.

Add signal processing
The Signal Processing (SP) Tool Kit window is visible when you are 
working in the ESP-88 window. The SP Tool Kit contains signal 
processing blocks that can be used in your design. Simply drag a block 
from the SP Tool Kit window into the ESP-88 window.

Figure 3.19 - Adding signal processing

The signal processing blocks are grouped by type. Click on the “+” next to 
a group to view the signal processing blocks. To open the control panel 
for any signal processing block, simply double-click on the block after you 
have added it to the ESP-88 window.
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Working with signal processing blocks

After placing signal processing blocks into the ESP-88 window, you can 
move one or more blocks around by selecting and dragging them with the 
mouse. You can also use the arrow keys on your keyboard to nudge the 
blocks into position. To line up blocks, use the options in the Edit menu. 
For example, to vertically align the left borders of a group of blocks, select 
all the blocks and choose Edit > Align Left Sides:

Figure 3.20 - Align Left Sides

Note: The output of a signal processing block can be wired to more than 
one input, but a signal processing block can only accept one input 
wire.
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Rename any signal processing block by right clicking and selecting 
Rename, or by pressing F2.

Figure 3.21 - Rename a signal processing block

To copy the settings in one signal processing block to another signal 
processing block of the same kind, right click on the block and select 
Copy Parameters. To paste these settings to another signal processing 
block of the same kind, select the signal processing block, right click and 
select Paste Parameters. 

Figure 3.22 - Copy and paste parameters between two signal processing blocks of the same 
kind
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DSP Resources
As you design your ControlSpace ESP-88 system, use the DSP 
Resources window to monitor the signal processing and delay usage for 
the ESP-88. To open the DSP Resources window, first select the ESP-88 
window, then choose Tools > DSP Resources, or press the DSP 
Resources button:

Figure 3.23 - DSP Resources

The DSP Resources window shows the percent capacity used for signal 
processing (DSP) and delay in the selected ESP-88.

Connecting to the ControlSpace ESP-88 system
After you have finished your system design, you need to connect to the 
ControlSpace ESP-88 system to upload the design into the ESP-88(s). If 
you have not already done so, you must first make the proper hardware 
connections to establish the local network for your ControlSpace ESP-88 
system. For more information on hardware connections and network 
settings, see Chapter 1: Configure the ControlSpace Designer network. 
There are two methods by which you can go on-line: download and 
upload. Most often, you will make changes to, or create a design in 
ControlSpace Designer software, and then upload the design to the ESP-
88. Alternately, you can use the download option as a way to see the 
currently running configuration in a ControlSpace ESP-88 system.
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Go on-line

Uploading to the ESP-88

Once you have created your system, you can upload the design from 
ControlSpace Designer software to any ESP-88s, CC-64s and CC-16s in 
your system. Once you are connected to the hardware, press the Go on-
line button to upload your settings to the Flash memory in the ESP-88:

Figure 3.24 - Go on-line button

The Go Online window opens if the configuration in the ESP-88 Flash 
memory is different than the configuration in your design. Press the 
Upload button to load your design into the ESP-88.

Figure 3.25 - Go Online window
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Once the settings are uploaded, the background in Project View and the 
ESP-88 window turns blue to indicate that you are now working online.

Figure 3.26 - Working online

Real-time controls

You can make adjustments to parameters in your system while online. For 
example, you may want to adjust the equalization of your system while 
you are listening to it. The following is a partial list of actions that are 
allowed when the system is online:

•    Open and modify many signal processing block settings, 
such as EQs, Gains, Delays, and Compressors

•    Copy and paste parameters from one signal processing 
block to another

•    Use the CC-64 and CC-16 Smart Simulators to simulate 
user controls.
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In general, signal flow and connections cannot be changed when the 
system is online. The following is a partial list of actions that are NOT 
allowed when the system is online:

•    Changes in wiring between signal processing blocks and 
devices

•    Adding or removing signal processing blocks and devices

Note: You must go off-line before disconnecting your computer from the 
local network.

Downloading settings: connecting to an existing ControlSpace 
ESP-88 system

You also have the option to download the system configuration from the 
hardware to ControlSpace Designer software. This is useful if you are 
connecting to an existing ControlSpace ESP-88 system and you do not 
have the original .csp project file. Follow these steps to download an 
existing configuration to ControlSpace Designer software:

1.  Connect to the ControlSpace local hardware network.

2.  Launch ControlSpace Designer software and create a new project 
file.

3.  Press the Scan button to identify what hardware exists on the 
local network. This is necessary for ControlSpace Designer 
software to recognize the hardware components that it will upload 
to or download from.

Figure 3.27 - Scan button

4.  Press the Go on-line button.

Figure 3.28 - Go on-line button
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5.  Press the Download button in the Go Online window.

Figure 3.29 - Go Online window

Choose which settings you would like to download:

Running - Download the settings as they currently exist in the 
ControlSpace ESP-88 system. This includes any settings that 
have been changed in the system since the configuration was 
last loaded (or since the last time the system was powered 
on). For example, if you just changed the gain of an output 
from 0 dB to 7dB, the running settings will be downloaded with 
the gain at 7 dB.

Saved - Download the settings as they were last loaded into 
the ESP-88 Flash memory. This does not include any settings 
that have been changed in the system since the configuration 
was last loaded.

Cancel - Cancel the download.
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After downloading the settings, the system will be on-line with the existing 
configuration in your ControlSpace project file.

Go off-line
To disconnect from the ControlSpace ESP-88 system while on-line, press 
the Go off-line button.

Figure 3.30 - Go off-line button

You are asked whether or not you want to save the currently running 
settings to the Flash memory in the ESP-88. The currently running 
settings include any settings that have been changed in the system since 
going on-line, for example any EQ adjustments you made while on-line.

Figure 3.31 - Save settings when going off-line
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Chapter 4: Store system programming
ControlSpace Designer software allows you to set up signal processing 
associations, and configurations to meet the unique needs of your project. 
For example, a restaurant may need three different settings for breakfast, 
lunch, and dinner. You can store these different “scenes” and they can be 
recalled later. 
ControlSpace Designer software provides four different methods for you 
to capture these settings: groups, parameter sets, presets, and timers. 
These windows are also known as the Control Library.

•    Groups - The behavior of two or more similar signal 
processing blocks can be linked together by adding them 
to a group. Once they are grouped, the behavior of these 
functions or signal processing (SP) blocks will be 
synchronized. For example, you could group two gain 
blocks together and then control both using a master 
fader.

•    Parameter Sets - Sometimes called scenes or sub-
presets, parameter set are a collection of signal 
processing blocks and their settings. You can capture the 
state of one or more signal processing blocks, inputs, or 
outputs by adding them to a parameter set. The captured 
state of these blocks can then be recalled later. For 
example, you may want to select a CD player as a sound 
source, and decrease the gain to a specific level. To store 
a snapshot of this state, set your signal processing blocks 
to the proper settings (CD source selected, gain set) and 
drag them into a parameter set. Your settings are stored, 
and can be recalled at any time.

•    Presets - Whereas parameter set are a snapshot of a part 
of your system, preset store the state of all devices in the 
entire system. They are used when you want to initialize 
or change the state of the entire system.

•    Timers - Timers allow you to schedule certain events in 
your system to occur on a certain date, a certain time of 
day, or on a weekly schedule. For example, you could 
schedule an increase in system volume every day at 5 
pm.
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Groups
ControlSpace Designer software allows you to link the behavior of two or 
more similar signal processing blocks using groups. There are two types 
of groups: grouped signal processing blocks and grouped gains. When 
you group signal processing blocks together (such as two Parametric 
EQs), the settings are synchronized: changes to one block affect the 
others in the group. When gain controls are grouped together, they can be 
controlled together by a master fader. However, the gains are not 
synchronized; individual changes are still allowed, for example, to set 
different trim levels. ControlSpace Designer software can store up to 128 
groups. Open the Groups window by choosing Window > Groups.

Figure 4.1 - Groups window
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You can drag and drop two or more similar blocks from the ESP-88 
window to create a group. In this example we will create a group called 
“CD” since we do not need to independently adjust the input levels of the 
CD L and CD R sources. Follow these steps to group two input blocks 
together:

1.  Select two input blocks by holding the Ctrl key and clicking on 
them, and drag them onto the “Group 1: “Group 1”” text line.

Figure 4.2 - Drag and drop into a group

In the case of input, output, and gain blocks, you are 
prompted to choose the properties of the block you want to 
group: Level + Mute, Level, or Mute. Choose Level + Mute 
and click OK. Both Level and Mute will be controlled for these 
inputs.

Figure 4.3 - Choose properties
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2.  Rename the group by selecting the group in the Groups window 
and pressing F2, or right click and choose Rename. Name the 
group “CD”.

Figure 4.4 - Rename the group

3.  In the Groups window, right click on Group 1: “CD”, and select 
Master Fader....

Figure 4.5 - Open the Master Fader

The Master Fader opens. Use this fader to control both of the 
inputs in the group. 
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4.  To verify the correct behavior, open the Master Fader, and both 
input control panels. Move the slider on the Master Fader. The 
input sliders are controlled by the Master Fader.

Figure 4.6 - Adjust the gain on the Master Fader to change the gain on both inputs.

Note: The grouped faders will maintain their relative positions when 
adjusting the Master Fader. You can change the level of an 
individual group member at any time. As the Master Fader is 
moved, an individual gain stops when it reaches its upper or lower 
limit, but the other gains in the group will continue to move. When 
the Master Fader is moved back, the relative gains are maintained 
as the stopped gain comes off its upper or lower limit.
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You can view the contents of a group by expanding the tree structure for a 
group in the Groups window. The tree structure displays the devices that 
are included in the group and the properties that are controlled in the 
group.

Figure 4.7 - Group tree structure

After storing a group, the Clear button in the Groups window is 
highlighted in orange. This indicates that a group has been stored. To 
clear the contents of the group, press the orange Clear button.

Figure 4.8 - Stored group
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To add a group, right click underneath the Clear buttons and choose Add 
Group. The new group is added after Group 16.

Figure 4.9 - Adding a group

Note: If you want to change which properties (Level, Mute) are controlled 
in a group, you must first clear the contents of the group, then re-
drag the blocks into the group.

When two signal processing blocks (other than gain blocks) are grouped 
together, their settings are synchronized. Changes to one block 
automatically affect the others in the group. For example, you could group 
two Selector type blocks together if you want to synchronize their 
settings. Drag the two Selector blocks into a new group, then open both 
control panels. Notice that when you change the channel on one Selector 
block, the other Selector changes to the same channel.

Figure 4.10 - Changes to Selector 1 are mimicked in Selector 2
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Besides dragging and dropping from the ESP-88 window, the following 
are two additional methods by which you can add blocks to a group:

• Select one or more blocks, right click, and choose Add To Group.

Figure 4.11 - Right click to add to a group
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• Create a group using the Group Nodes List. Right click on the 
group name in the Groups window, and choose Group Nodes 
List.... The Group Nodes List window opens showing all blocks 
that are available for grouping.

Figure 4.12 - Open the Group Nodes List window
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Place a checkmark in the box next to the items you want to add to 
the group. Note that after you place the first checkmark, only 
blocks of the same type are available for grouping. Other non-
compatible blocks are grayed out. In Figure 4.13 below, a gain 
(input) type block has been checked in the Group Nodes List. 
This block can only be grouped with other gain type blocks, so all 
non-gain type blocks are automatically grayed out.

Figure 4.13 - Only blocks of the same type (in this case gain) can be grouped 
together
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Parameter Sets
Parameter sets are a collection of signal processing block settings. A 
parameter set stores a snapshot of these settings which can later be 
recalled or invoked. Use parameter sets when you want to change the 
state of specific parameters without affecting the state of the entire 
design. 

Creating parameter sets
To open the Parameter Sets window, choose Window > Parameter 
Sets.  

Figure 4.14 - Parameter Sets window
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To create a parameter set first set the signal processing to the desired 
state. Then select the signal processing blocks in the ESP-88 window 
whose state you want to store, and drag and drop them onto a parameter 
set in the Parameter Sets window.

Figure 4.15 - Drag and drop blocks into the parameter set
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The state of the signal processing block is now stored in the parameter 
set. To verify what settings are contained in a parameter set, expand the 
tree structure in the Parameter Sets window. The tree structure displays 
each block that is included in the parameter set, and the state of the 
settings for each block.

Tip: Double-click on a name in the tree structure to open the control 
panel for that device or block.

Figure 4.16 - Parameter set tree structure

To rename the parameter set, select the top level of the tree structure and 
press F2, or right click and choose Rename. 

Figure 4.17 - Rename the parameter set
   Chapter 4: Store system programming                                         69



Bose® ControlSpace™ Designer™ Software User Guide
Another way to add blocks to a parameter set is to select one or more 
blocks, right click, and choose Add To Parameter Set.

Figure 4.18 - Right click to add to a parameter set

Note: To change the value of a setting in the parameter set, first change 
the setting in the control panel and then re-drag the block into the 
parameter set. You do not need to delete the block from the 
parameter set.
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Parameter Set Nodes List
You can also create or modify a parameter set by using the Parameter 
Set Nodes List. Double-click on the parameter set name in the Parameter 
Sets window, or right click and choose Parameter Set Nodes List.... The 
Parameter Set Nodes List window opens showing all signal processing 
nodes in your system.

Figure 4.19 - Open the Parameter Set Nodes List
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Note that you can expand most blocks to view the individual settings for 
the block.

Figure 4.20 - Expand a device to see properties

If you are creating a new parameter set, you can specify exactly which 
settings you want to store. To store all settings for a given block, place a 
check mark next to the block name, as shown in Figure 4.21. Note that all 
the settings within the block are automatically selected.

Figure 4.21 - Include all settings for the device
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Storing discrete parameters

To include only specific settings in the parameter set, use the Parameter 
Set Nodes List and place a check mark next to the settings within the 
block, as shown in Figure 4.22. For example, you may want your 
parameter set to set the gain level of an input block, but not affect the 
mute status. When this parameter set is invoked, only the selected 
settings will be changed. The settings that are not checked are not part of 
the parameter set and remain unchanged when the parameter set is 
invoked. 

Figure 4.22 - Include only the selected settings in the parameter set

You can also use the Parameter Set Nodes List to modify an existing 
parameter set. Open the Parameter Set Nodes List and check or uncheck 
the settings that you want to include in the parameter set.

Changing values in parameter sets
If you need to change the value of a setting that is part of a parameter set 
(for example, a gain of -6 dB) you will need to change the setting in the 
ESP-88 window, the re-drag the block into the parameter set. The values 
of parameters are displayed but cannot be changed within the Parameter 
Sets window.
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Recalling parameter sets
The Recall buttons in the Parameter Sets window are change to orange 
when a parameter set is stored. Pressing recall changes the state of all 
specified signal processing blocks to the values stored in the parameter 
set. You can open the individual signal processing block control panels 
and then recall parameter sets to verify that you have stored the correct 
settings.

Clearing parameter sets
To clear the contents of a parameter set, right click on the top level of the 
tree structure, and select Clear, or press Delete.

Figure 4.23 - Clear a parameter set

Presets
Presets are a snapshot of the state of the entire system including all 
signal processing blocks, CC-64 and CC-16 programming. Presets are 
also the only way to dynamically change the programming of the CC-64 
and CC-16 controllers. Because presets are “global” settings, meaning 
they affect every setting of every device, you should only use them if you 
want to initialize or change the state of the entire system, or if you need to 
change how a CC-64 or CC-16 is programmed.

Note: Presets can only be invoked by a General Purpose Input (GPI) or a 
timer. Presets cannot be invoked by a CC-64 or CC-16. 
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Creating presets
To open the Presets window, go to Window > Presets.

Figure 4.24 - Presets window

To store a preset, first set your system to the desired state. Then simply 
press the Store button in the Presets window. The preset is automatically 
populated with all devices and all settings in your system design. The 
Store and Recall buttons will turn orange to indicate that a preset has 
been stored. You can view all the devices and settings in a preset in the 
tree structure in the Presets window.

Figure 4.25 - Preset tree structure
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To rename a preset, right click on the top level of the tree structure and 
press F2, or right click and choose Rename.

Figure 4.26 - Rename a preset

Recalling presets
To recall the system to the state that is stored in the preset, press the 
Recall button in the Presets window.

Figure 4.27 - Recall a preset
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Changing presets
To change an existing preset, configure the signal processing then press 
the Store button again. You are asked whether you would like to overwrite 
the existing preset.

Figure 4.28 - Changing an existing preset

Clearing presets
To clear the contents of a preset, right click on the top level of the tree 
structure, and select Clear.

Figure 4.29 - Clear a preset
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Timers
Timers allow you to schedule changes in the signal processing settings. 
You can schedule a change to take place on a specific date and time, at 
the same time every day, or at a time on specific days of the week. For 
example, you could schedule a change in source selector to take place 
every day at 5:00 pm.

Creating timers
To open the Timers window, go to Window > Timers.

Figure 4.30 - Timers window
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To store a timer, first set the appropriate blocks in the ESP-88 window to 
the state they will change to at the specified time. Then drag the blocks 
into a timer in the Timers window.

Figure 4.31 - Drag and drop into the Timers window
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Timer Setup
When you first create a timer, the Timer Setup window opens. Use this 
dialog to specify the type and schedule for the timer event.

Figure 4.32 - Timer Setup window

You can program your settings to be invoked Only Once, Daily, or 
Weekly.

•    Only Once - The settings will be invoked on the specified 
date and time.

•    Daily - The settings will be invoked every day at the 
specified time.

•    Weekly - The settings will be invoked at the specified time 
on the specified days of the week.

To change the setup of a stored timer, double-click on the timer in the 
Timers window, or right click and choose Set Date Time.... The Timer 
Setup window opens.
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Another way to add blocks to a timer is to select one or more blocks, right 
click, and choose Add To Timer.

Figure 4.33 - Right click to add to a timer
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You can program a timer to invoke a parameter set by dragging a 
parameter set from the Parameter Sets window to the Timers window. 
After selecting and dragging the parameter set, hold your mouse over the 
Timers window tab to bring the Timers window to the front. You can also 
hold your mouse over the timer selection buttons to automatically select a 
timer before dropping the parameter set into a timer (see Figure 4.34 for 
clarification.)

Figure 4.34 - While dragging, hover over a tab or button to bring it to the front
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Recalling timers
To recall the system to the state that is stored in the timer, press the 
Recall button in the Timers window.

Figure 4.35 - Recall a timer

Clearing timers
To clear the contents of a timer, right click on the top level of the tree 
structure, and select Clear.

Figure 4.36 - Clear a timer

Note: The main ESP-88 in your system acts as the Real Time Clock (RTC) 
which triggers timers. The RTC is automatically set to the time, 
date, and time zone of your computer. Always be sure to set your 
computer to the local time and time zone if using timers.
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Using the Project Directory
You can also create system programming using the Project Directory 
window. The Project Directory window contains all objects in your 
system design in a tree structure format. To open the Project Directory 
window, go to Window > Project Directory.

Figure 4.37 - Project Directory window
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The Project Directory window is a master directory of your system 
design. All devices, signal processing blocks, inputs, outputs and 
programming functions can be found here. You can program groups, 
parameter sets, and timers by dragging and dropping signal processing 
blocks into the Project Directory window. For example, to program a 
parameter set, select the signal processing blocks and drag them into the 
parameter set tree structure.

Figure 4.38 - Drag and drop into the Project directory to program a parameter set
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Use the tabs at the top of the Project Directory window to select a sub 
category of objects in your design.

Figure 4.39 - Tabs in the Project Directory
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Chapter 5: Program user controls: CC-64 and CC-16
ControlSpace Designer software allows for a great amount of flexibility in 
how the user will control the system. Your user control needs depend on 
the system design, and the needs of your customer. Your system might 
be a static signal processing tool, and require no user controls, or it might 
be a multi-room, multi-zone solution requiring both CC-64 and CC-16 
controllers, along with general purpose switches and potentiometers. This 
chapter covers how to program the CC-64 and CC-16 controllers.

Programming overview
The CC-64 and CC-16 controllers can be programmed to control or 
invoke the following objects in ControlSpace Designer software:

•    Gain blocks (including Input and Output blocks)
•    Grouped Gain blocks

•    Selector blocks
•    Parameter sets
•    Certain signal processing blocks (for example crossover 

and EQ) using custom settings in a CC-64
Once you have established your signal processing design, programming 
is accomplished by dragging and dropping the object you would like to 
control onto the appropriate user control.
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CC-64 Control Center
The CC-64 Control Center is often the primary user interface for a 
ControlSpace engineered sound system. The CC-64 has a logical 
interface that includes four rotating control knobs, a selector knob and a 
two line by 40 character backlit LCD display. Each knob is fully 
programmable, as is the LCD text display. The four control knobs can 
control up to four different banks, for a total of sixteen settings. Use 
multiple banks if you need to control more than four parameters with the 
control knobs. Use the Bank Selector buttons to select a different bank.

Figure 5.1 - CC-64 front panel

As shown in Figure 5.1, each control knob is surrounded by green LED 
lights which indicate the relative position of the control knob. The bottom 
line of the LCD display serves as labels for the control knobs. 

Figure 5.2 - Selector knob and Bank 1control knob labels
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For example, the first knob in Figure 5.2 controls the level of the Head 
Mic, the second knob controls the level of the Podium Mic, and so on. If 
you were to select Bank 2 by pressing the Bank Selector button, the four 
knobs might control four different volumes. The labels in the LCD screen 
change to indicate the knob functions in Bank 2. The top line of the LCD 
display indicates the parameter set that is currently being used, “Large 
Meeting Configuration”.

CC-64 Smart Simulator
The CC-64 Smart Simulator is used to program the CC-64 controls, as 
well as to simulate the behavior of the CC-64 in your system. The Smart 
Simulators work while on-line and off-line. To open the CC-64 Smart 
Simulator, double-click on the CC-64 in Project View.

Figure 5.3 - CC-64 Smart Simulator
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As shown in Figure 5.3, the top half of the Smart Simulator is a graphical 
representation of the front panel of the actual CC-64 controller, and the 
bottom half is the programming tree. Once programmed, you can operate 
the knobs and buttons in the Smart Simulator using your mouse. Click the 
Mute button above a control knob to simulate muting the channel.

Programming the CC-64

The programming tree in the lower half of the Smart Simulator is used for 
assigning functions to the controls on the CC-64. The controls on the CC-
64 can be programmed with the following objects in ControlSpace 
Designer software:

• Program control knobs with:
•    Gain blocks (including Input and Output blocks)
•    Selector blocks
•    Groups of gain blocks
•    Parameter sets

• Program the Selector knob with:
•    Parameter sets
•    Selector blocks

When you open the Smart Simulator, the controls for Bank1 are displayed 
in the programming tree. You can assign functions to controls 1-4, which 
correspond to control knobs 1-4, by dragging and dropping from the ESP-
88 window onto the controls.
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Figure 5.4 - Drag a sound processing block onto a Bank 1 control

Figure 5.5 - Controls in Bank 1
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To assign functions for the control knobs in Bank 2, select the Bank 2 tab 
at the bottom of the Smart Simulator window or press the Bank 2 selector 
button (shown in Figure 5.6). Drag and drop functions onto the controls. 
The LCD display in the Smart Simulator shows what is displayed on the 
actual CC-64.

Figure 5.6 - Assign functions to Bank 2
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To assign functions to the Selector knob, choose the Selector tab at the 
bottom of the Smart Simulator window. Drag and drop a Selector sound 
processing block, or parameter set onto the Selector.

Figure 5.7 - Drag and drop a parameter set into the Selector

You can verify your programming by clicking on the Selector arrows in the 
Smart Simulator. You will see the display switch between the two 
parameter sets.

Figure 5.8 - Test the programming by switching between two parameter sets
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A control knob can also act as a selector. If you program a control knob to 
invoke parameter sets or control a selector block, the control will change 
to selector arrows in the Smart Simulator:

Figure 5.9 - A control knob programmed to invoke parameter sets

Custom settings

The CC-64 supports a custom mode, whereby you can access settings 
for certain signal processing blocks such as EQ blocks, and crossover 
blocks. You can program the CC-64 to control the following signal 
processing block types in custom mode:

• Crossover
• Graphic EQ
• Tone control EQ
• Parametric EQ
• Delay
• Signal Generator
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To add signal processing blocks to the custom control, drag and drop one 
or more blocks listed above onto the Custom control. The Smart 
Simulator displays the list of blocks assigned to custom control mode.

Figure 5.10 - Drag a Parametric EQ block onto a Custom control

Note: To access the Custom controls from the CC-64 hardware, press and 
hold the Selector knob for 5 seconds.
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Control Properties

You can use ControlSpace Designer software to specify the maximum 
value, minimum value, and step size for each rotating control knob. To 
access control knob volume properties, right click on the Property line 
within a Control tree structure.

Figure 5.11 - Right click on a Property to access control knob volume properties

The volume properties dialog box opens:

Figure 5.12 - Volume property dialog box
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You can adjust the following settings:
•    Max - The maximum volume for the control knob, in dB. 

Values are rounded to the nearest 0.5 dB and must be 
between -59.5 dB and12 dB.

•    Min - The minimum volume for the control knob, in dB. 
Values are rounded to the nearest 0.5 dB and must be 
between -60 dB and 11.5 dB.

•    Step - The increment of change in dB for each click as the 
knob is turned. Step size can be set between 0.5 dB and 
36.5 dB.

There must be at least 0.5 dB between the Max and Min. You can verify 
your setting by turning the control knob in the CC-64 Smart Simulator. As 
you turn the knob, watch the LCD display to see the step size and the 
Max and Min volume settings.

Locking the CC-64

When the CC-64 is locked, the user controls are disabled. This is useful if, 
for example, you have multiple CC-64s in your system. You may require 
that in a certain situation the user only controls the system with one of the 
CC-64s. For example, during a crowded event in a function room, you do 
not want an accidental change of the settings on a CC-64 located in the 
function room. You want to control the system solely from a CC-64 in the 
private office. In this case you can set the CC-64 in the function room to 
be locked. The lock/unlock status of a CC-64 must be stored in a 
parameter set. When this parameter set is invoked, the CC-64 is locked 
or unlocked. To store the lock/unlock status in a parameter set, first set 
the lock button on the CC-64 Smart Simulator, then drag the CC-64 from 
Project View into a parameter set. The lock status is the only CC-64 
setting that is stored in a parameter set. 

Figure 5.13 - Press the Lock button to lock the CC-64
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Figure 5.14 - Drag the locked CC-64 into a parameter set

If you want to change the CC-64 lock status in the parameter set, you 
must reset the lock and then re-drag the CC-64 into the parameter set. 

Note: Be careful not to add a parameter set to a CC-64 that locks itself 
unless you have another user control that can unlock the CC-64. 
Otherwise the user can become “locked out” of the system.
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CC-64 Properties
To access other CC-64 properties, right click on the CC-64 in Project 
View and select Properties.

Figure 5.15 - Access CC-64 properties

Figure 5.16 - CC-64 Properties window
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You can access settings for each control knob as well as the Selector 
knob using the tabs at the top of the window. Press the Control buttons to 
switch between control knobs in a given bank.

Figure 5.17 - Tabs and buttons.

You can set the max, and min levels, and step size for each control in the 
four banks of selector knobs. 

Figure 5.18 - Max, min, step size and label

You can also type in the label for the control knob in the Label field. This 
label will appear on the LCD display regardless of what the programmed 
control is named. For example, you may have programmed a control with 
“CD In”, but you want the user to see “CD Player” on the LCD screen 
above the control knob. You would type “CD Player” in the Label field.

Figure 5.19 - Labeling control knobs
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If you program a control knob to invoke parameter sets or control a 
Selector block, the Bank Selector fields indicate the labels that are 
displayed for each setting.

Figure 5.20 - Bank Selector fields

Select the Selector tab to enter the labels that are displayed for the 
Selector knob settings.

Figure 5.21 - Selector labels
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The fields at the bottom of the Properties window are used to rename the 
CC-64, and to set the IP address for the CC-64 in your design.

Note: The IP address in the Properties window must match the IP address 
of the actual CC-64 before you upload your design.

Figure 5.22 - Common settings
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CC-16 Zone Controller
The CC-16 Zone Controller is a wall-mountable control panel. The CC-16 
includes two selector buttons, and two volume control buttons, along with 
a two-line backlit LCD display. The selector and control buttons are fully 
programmable.

Figure 5.23 - CC-16 front panel
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CC-16 Smart Simulator
The CC-16 Smart Simulator is a graphic display that simulates the CC-16 
Zone Controller. You can use the Smart Simulator to program the CC-16 
controls, as well as to simulate the behavior of the CC-16 in your system. 
To open the CC-16 Smart Simulator, double-click on the CC-16 in Project 
View.

Figure 5.24 - CC-16 Smart Simulator

As shown in Figure 5.24, the top half of the Smart Simulator is a graphical 
representation of the front panel of the actual CC-16 controller. You can 
operate the selector and volume control buttons using your mouse. 

Programming the CC-16

The programming tree in the lower half of the CC-16 Smart Simulator is 
used for assigning functions to the controls on the CC-16. Assign 
functions to the Select buttons, or to the Volume control buttons by 
dragging and dropping onto the programming tree in the Smart Simulator.
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Figure 5.25 - Assign functions in the programming tree of the CC-16 Smart 

Simulator window

Figure 5.26 - Assigning functions to CC-16 buttons
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The buttons on the CC-16 can be programmed with the following objects:
• Select buttons:

•    Selector blocks
•    Parameter sets

• Volume control buttons:
•    Gain blocks (including Input and Output blocks)
•    Groups of gain blocks

Volume control button properties

You can use ControlSpace Designer software to specify the maximum 
value, minimum value, and step size for the volume control buttons. The 
CC-16 displays volume levels from 00 (min) to 99 (max). You can specify 
the maximum and minimum values using the volume control button 
properties. To access the volume control button properties, right click on 
the Property line within the Volume programming tree.

Figure 5.27 - Right click on Property to access volume control properties
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Figure 5.28 - Volume properties dialog box

Specify the Maximum volume, Minimum volume and Step size in decibel 
values in the boxes to the left. Step size is the incremental change in 
decibels each time the “+” or “-” volume button is pushed. The numbers to 
the right indicate what is displayed on the CC-16 LCD display. As you 
change the Max, Min and Step values in the boxes on the left, the step 
value is automatically updated on the right. The Max display value will 
always be 99, and the Min display value will always be 1 (or 0 if you set 
the Min to -infinite decibels). After setting the volume properties, use the 
volume control buttons on the Smart Simulator to verify what the user will 
see in the LCD display.

Locking the CC-16

When the CC-16 is locked, the select and volume control buttons are 
disabled. You might use this feature if, for example, you have multiple 
CC-16s in your design, and need to disable one or more for a certain 
configuration. Like the CC-64, The lock/unlock status of a CC-16 must be 
stored in a parameter set. When this parameter set is invoked, the CC-16 
is locked or unlocked. To store the lock/unlock status in a parameter set, 
first set the lock button on the CC-16 Smart Simulator to the locked or 
unlocked state, then drag the CC-16 from Project View into a parameter 
set. The lock status is the only CC-16 setting that is stored in the 
parameter set.
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Figure 5.29 - Set the lock button on the CC-16 Smart Simulator

Figure 5.30 - Drag the locked CC-16 into a parameter set

If you want to change the CC-16 lock status in the parameter set, you 
must reset the lock and then re-drag the CC-16 into the parameter set. 
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CC-16 Properties
To access other CC-16 properties, right click on the CC-16 in Project 
View and select Properties.

Figure 5.31 - Access CC-16 Properties

Figure 5.32 - CC-16 Properties window
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After programming the Select buttons, you can change the text that is 
displayed on the LCD screen by typing in the Select Label fields.

Figure 5.33 - Entering Select labels

You can set the max, and min levels, and step size for the Volume 
buttons on the CC-16 in the Properties window (see Volume control 
button properties above.)

Figure 5.34 - Volume control properties
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The fields at the bottom right of the Properties window are used to 
rename the CC-16, and to set the ID number for the CC-16 in your 
design.

Figure 5.35 - Name and ID settings
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Chapter 6: Program GPI/O and Serial Input/Output

General Purpose Inputs (GPI)
The ESP has 8 GPI that can be expanded to 16 GPI with the addition of a 
GPIO expansion card. GPI are used to connect external hardware such 
as potentiometers (to control levels or gains) and switches (to select a 
parameter set or preset). You assign functions to the external control in 
the GPI control panel in ControlSpace Designer software.

Figure 6.1 - Example GPI connections with a switch above and potentiometer below
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To open the GPI control panel, double-click on the GPI block in the ESP-
88 window.

Figure 6.2 - Open the GPI control panel

Use the programming tree in the bottom half of the GPI control panel to 
assign functions that are invoked by the eight General Purpose Inputs. 
You can drag and drop signal processing blocks, parameter sets, groups, 
or presets onto the text lines. The top half of the GPI control panel 
contains Mode buttons to switch between operating modes, and Test 
buttons to simulate the behavior of an assigned function.
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Operating modes
General Purpose Inputs can be configured to operate in one of three 
modes: digital, up/down, and analog. Use the Mode buttons in the GPI 
control panel to switch a GPI to a different mode. 

Operating Mode Description

Digital Typically used when connecting a switch or push button, 
this mode expects a normally open switch for operation. 
Both “on” and “off” actions are supported

Up/Down Up/Down mode uses two adjacent GPI, and is intended to 
support two push buttons for use as volume up and down. 
Normally open switches are expected.

Analog Analog mode is intended for a 10K linear type 
potentiometer that can be linked to a gain control or 
grouped gains. When the potentiometer is at the 10 KOhm 
position the gain is set to minimum, and when the pot is at 
the 0 KOhm position, the gain is set to the maximum level.
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Programming GPI
To program a GPI, drag and drop from the ESP-88 window onto a text line 
in the programming tree of the GPI control Panel. For example, to 
program a potentiometer on GPI 1 to control the wireless mic gain, first 
switch the GPI to analog mode, then drag the wireless mic input block 
onto “Analog Control Input 1:”

Figure 6.3 - Assign the Wireless Mic input to a GPI 
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Invoking signal processing blocks using a GPI

You can use a switch or button connected to a GPI to recall a snapshot of 
blocks in your system. When the external switch or button is pushed, the 
block’s settings are returned to the pre-defined state. For example, you 
could use an external button to switch a Selector block to a certain input. 
To do this, first set the Selector block to the desired state. Then drag the 
signal processing block into the appropriate GPI. This action takes a 
snapshot of the signal processing block and saves it to the GPI 
programming. The GPI should be in digital mode to invoke a signal 
processing block, so set the mode button to digital.

Figure 6.4 - Assign a Selector block to a digital GPI
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When you assign a signal processing block to a digital GPI, the Set Mode 
window opens. This window is used to designate whether the snapshot of 
the signal processing block is recalled when the external switch is closed 
(ON) or open (OFF).

Figure 6.5 - Set Mode window

If there is only one action that is invoked by the external controller, then 
choose ON or OFF based on which state should invoke the signal 
processing block -- going active “ON”, or going active “OFF”. You do not 
have to program both states. If there are two actions that are invoked by 
the external controller, you can program both ON and OFF states. Drag 
the block onto the same GPI but this time select the OFF state. Both 
states will be programmed to the GPI.

Note: One scenario in which you might program both ON and OFF states 
is the case of a “push-to-talk” button for a microphone. You could 
program the system to mix in the microphone when the button is 
pushed, and to remove the mic from the mix when the button is 
released. 
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Open the GPI tree structure to verify what has been programmed.

Figure 6.6 - Open the tree structure to view what is programmed

All signal processing blocks (except meters) can be invoked by an 
external switch in this “snapshot” manner using a GPI in digital mode. You 
can also invoke multiple blocks with an external switch in this manner by 
dragging multiple blocks into one GPI programming tree.

Invoking a parameter set

Parameter sets can be invoked by an external controller using a GPI in 
digital mode. Drag the parameter set into the GPI control panel and drop it 
into the desired control input. Drag multiple parameter sets into the GPI to 
invoke multiple parameter sets with the same external switch or button. 
After dragging the parameter sets into the GPI, choose the appropriate 
ON/OFF mode in the Set Mode window.

Invoking a preset

A preset can only be invoked using a timer or a GPI. To invoke a preset 
using a GPI, select digital mode, and then drag the preset into the GPI 
control panel and drop it into the desired control input. 
   Chapter 6: Program GPI/O and Serial Input/Output                    119



Bose® ControlSpace™ Designer™ Software User Guide
Controlling a group

Grouped gains can be controlled by GPIs in analog mode, digital mode, 
or up/down mode. Drag a group of gain controls into a GPI according to 
the following logic:

• Digital mode - The external button or switch will control the Mute 
status only

• Analog mode - The external potentiometer will control Level only
• Up/Down mode - The external buttons will control Level only

Discrete mode

When using an external switch or button to control a group in digital 
mode, ControlSpace supports a discrete, or 1:1 connection between the 
control and the Mute status. This discrete connection can be set to one of 
three different modes. You are prompted to choose a mode when you 
drag and drop the group into the GPI control input.

Figure 6.7 - Choose a discrete mode

•    Active Hi. - Grouped state is invoked when the external 
control is activated (normally open switch = closed).

•    Active Lo. - Grouped state is invoked when the external 
control is deactivated (closed switch = open).

•    Toggle - Grouped state is toggled as the external control 
is toggled.

Discrete mode is only supported for groups, not for individual gain blocks. 
If you want to control an individual gain block with GPI in discrete mode, 
you will need to create a group and drag the gain block into the group, 
then assign the group to a GPI.
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Using a potentiometer

Use a GPI in Analog mode when connecting an external potentiometer 
control. A potentiometer can be used to control a gain block, or a group of 
gains. For example, your system might only require a main volume knob 
mounted to the wall. Drag the gain block or group into an Analog input in 
the GPI control panel.

Figure 6.8 - Drag a group onto a GPI set to analog mode
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You can adjust the maximum, minimum and step size for the analog 
control. Right click on Property in the GPI tree structure and choose Edit 
Volume Property. The Volume Property dialog box opens.

Figure 6.9 - Open the Volume Property dialog box

Set the minimum and maximum volume levels and step size in decibels. 
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Using up and down buttons for volume control

Use a GPI Digital Up/Down input to control a volume level using two 
buttons. Up/down buttons can be used to control a gain block, or a group 
of gains. Drag the gain block or group into a Digital Up/Down input in the 
GPI control panel.

Figure 6.10 - Drag a group onto a GPI set to up/down mode

You can adjust the maximum, minimum and step size for the Digital Up/
Down control. Right click on Property in the GPI tree structure and 
choose Edit Volume Property. The Volume Property dialog box opens. 
Set the minimum and maximum volume levels and step size in decibels.
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Testing GPI

Use the Test buttons in the GPI control panel to simulate the operation of 
a GPI. In analog mode, such as when a potentiometer is attached, 
pressing the test button will pop up a fader control. In digital mode, the 
test buttons will simulate ON and Off states.

Figure 6.11 - Digital and analog test buttons
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General Purpose Outputs (GPO)
The ESP-88 has 8 GPO that can be expanded to 16 GPO with the 
addition of a GPIO expansion card. GPO are often used as indicators that 
are activated when the system is in a certain state. For example, you 
might use GPO to signal an external device, like a video switcher, when a 
certain parameter set is chosen. Or, you could attach an LED to a GPO 
and program it to illuminate when a parameter set is invoked. 

Note: GPO can only be controlled by a timer, or by invoking a parameter 
set. 

To open the GPO control panel, double-click on the GPO block in the 
ESP-88 window.

Figure 6.12 - Open the GPO control panel
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Set the state of a specific GPO channel by clicking on the ON/OFF 
button. 

Figure 6.13 - Click a button to set the GPO state

Programming GPO
The process for programming a GPO is different than that of a GPI. There 
are two ways to program a GPO. The first method is to use the Project 
Directory. After setting the state of the GPO to ON or OFF, find the GPO in 
the Project Directory window, and drag it into a parameter set, or timer. 
When the parameter set is invoked or the timer expires, the GPO will 
change to the programmed state (ON or OFF).

Figure 6.14 - Drag a GPO from the Project Directory to a parameter set or timer
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The second method is to use the Parameter Set Nodes List (this only 
applies to parameter sets). To program a GPO to be activated by a 
parameter set, open the Parameter Set Nodes List by right clicking on the 
parameter set name, and place a checkmark next to the desired GPO.

Figure 6.15 - Use the Parameter Set Nodes List to program a GPO
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Serial Inputs 
The ESP-88 has a serial port that can be used to send and receive serial 
strings or commands. The serial port is located on the back of the ESP-
88, and is configured for 38,400 baud, no parity, 8 bits, 1 stop bit, and no 
flow control. To open the Serial Input control panel, double-click on the 
SerialInput block in the ESP-88 window.

Figure 6.16 - Open the Serial Input control panel

You can program your ControlSpace ESP-88 system to recall a snapshot 
of a block, or invoke a parameter set when the ESP-88 receives a serial 
string. To program a Serial Input, drag and drop one or more blocks or 
parameter sets onto a text line in the programming tree of the control 
panel. Enter the serial string that is to be recognized by the system in the 
corresponding field in the upper half of the control panel. When the 
incoming serial string matches any of the eight strings entered, the block 
or parameter set programmed for that string is invoked. For example, you 
might receive the ASCII string “S2” from an external system indicating 
that “scene 2” has been selected, and ControlSpace should invoke the 
programmed signal processing block or parameter set.
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Note: The ESP-88 automatically assumes that each input string is 
terminated with one carriage return (CR). You must program the 
equipment sending the serial string to the ESP-88 to terminate the 
serial string with one CR at the end of each command. You do not 
need to enter this CR in the Serial Input entry windows.

Note: You must use hex when designating a control character like CR or 
LF. To designate a hex character, use backslash 0, then the hex 
value of the character (0-F).

Figure 6.17 - The input strings “S1” and “S2” invoke a parameter sets

Use the Test buttons on the Serial Input control panel to simulate the 
incoming serial string.
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Serial Outputs
The serial output device is used to send a serial string when a parameter 
set is invoked, or when a timer expires. To open the Serial Output control 
panel, double-click on the SerialOutput block in the ESP-88 window.

Figure 6.18 - Open the Serial Output control panel

There are two ways to program a Serial Output which are similar to 
programming a GPO. There are two ways to program a Serial Output. 
After typing the serial string or command into the Serial Output control 
panel, find the Serial Output in the Project Directory, and drag it into a 
parameter set or timer. When the parameter set is invoked, or the timer 
expires, the Serial string is sent out the Serial port on the ESP-88. For 
example, you could send a signal to a video switcher when a parameter 
set is invoked or a timer expires.
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Figure 6.19 - Serial output strings to be sent by the ESP-88

You can also use the Parameter Set Nodes List to program a Serial 
Output to be activated by a parameter set, . Open the Parameter Set 
Nodes List by right clicking on the parameter set name, and place a 
checkmark next to the desired Serial Output.

Figure 6.20 - Use the Parameter Set Nodes List to program a Serial Output
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Using the Project Directory
The Project Directory window contains all objects in your system design 
in a tree structure format. To open the Project Directory window, go to 
Window > Project Directory.

Figure 6.21 - Project Directory window
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The Project Directory window is a master directory of your system 
design. All devices, signal processing blocks, and programming are 
displayed in the tree structure. To see a particular object in your design, 
expand the appropriate tree structure. For example, to view the settings 
for an input block, click on Devices > ESP-88, and then click on the input. 

Figure 6.22 - Viewing input block settings
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By default, the All tab is selected at the top of the Project Directory 
window to display all objects in your design. You can select a different tab 
to view a sub category of objects. For example, select the Parameter 
Sets tab to view all parameter sets.

Figure 6.23 - Parameter Sets tab

You can use the Project Directory to program user controls without 
opening the Smart Simulators or GPI control panels. For example, to 
access the CC-64 controls, select the Devices tab in the Project 
Directory window, then click on the CC-64 > Standard.

Figure 6.24 - Access CC-64 controls in the Project Directory window
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You can drag and drop into the banked controls, Selector, and Custom 
controls just as you would with the CC-64 Smart Simulator. In the same 
manner, you can assign functions to a CC-16 buttons using the Project 
Directory window.

Figure 6.25 - Assign CC-16 controls in the Project Directory window

Drag and drop into the select and volume control buttons to assign 
functions.
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Chapter 7: Signal Processing (SP) Tool Kit reference
The Signal Processing (SP) Tool Kit contains the signal processing blocks 
that are available for use in your system design. The SP Tool Kit is visible 
any time you are working in the ESP-88 window. Use this chapter as a 
reference to available signal processing blocks.

Figure 7.1 - ESP-88 window with SP Tool Kit to the left
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Crossovers
A crossover divides an input signal into two or more frequency ranges, 
and sends each frequency range to a separate output.

2 way crossover

Figure 7.2 - 2 way crossover

The 2 way crossover divides an input signal into two frequency ranges, 
high and low, and sends these signals to two outputs marked H (high) and 
L (low). Double-click on the 2 way crossover block to open the control 
panel.
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Figure 7.3 - 2 way crossover control panel

The top section of the control panel is a graphical representation of the 
crossover settings. The line to the left represents the low frequency output 
level and the line to the right represents the high frequency output level. 
Use the bottom section of the control panel to adjust crossover settings.

Type

Type Slope
Butterworth 6 6 dB/oct
Butterworth 12 12 dB/oct
Butterworth 18 18 dB/oct
Butterworth 24 24 dB/oct
Butterworth 36 36 dB/oct
Butterworth 48 48 dB/oct
Bessel 12 12 dB/oct
Bessel 18 18 dB/oct
Bessel 24 24 dB/oct
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Frequency

Set the low pass and high pass cutoff frequencies.

Polarity

Set the polarity of the output signal.

Mute

Mute the output signal.

Link

Press the Link button to lock the low pass and high pass frequencies to 
the same number. This is only an option when both the low and high types 
are set to Butterworth or Linkwitz-Riley. If link is off, the low pass and high 
pass frequencies can be adjusted independently.

Bessel 36 36 dB/oct
Bessel 48 48 dB/oct
Linkwitz-Riley 12 12 dB/oct
Linkwitz-Riley 24 24 dB/oct
Linkwitz-Riley 36 36 dB/oct
Linkwitz-Riley 48 48 dB/oct
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3 way crossover

Figure 7.4 - 3 way crossover

The 3 way crossover divides an input signal into three frequency ranges, 
high, mid, and low, and sends these signals to three outputs marked H 
(high), M (mid), and L (low). Double-click on the 3 way crossover block to 
open the control panel.
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Figure 7.5 - 3 way crossover control panel

The top section of the control panel is a graphical representation of the 
crossover settings. The line to the left represents the low frequency output 
level, the middle line represents the mid frequency output level, and the 
line to the right represents the high frequency output level. Use the 
bottom section of the control panel to adjust crossover settings. The mid 
section includes type and frequency settings for both ends of the mid 
frequency curve.

Link

Press the Link button between the low and mid groups to lock the low 
pass and mid high pass frequencies to the same number. Press the Link 
button between the mid and high groups to lock the mid low pass and 
high pass frequencies to the same number. Linking is only an option when 
both types are set to Butterworth or Linkwitz-Riley. If link is off, the 
frequencies can be adjusted independently.
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4 way crossover

Figure 7.6 - 4 way crossover

The 4 way crossover divides an input signal into four frequency ranges, 
high, high mid, low mid, and low, and sends these signals to four outputs 
marked H (high), HM (high mid), LM (low mid), and L (low). Double-click 
on the 4 way crossover block to open the control panel.
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Figure 7.7 - 4 way crossover control panel

The top section of the control panel is a graphical representation of the 
crossover settings. The line to the left represents the low frequency output 
level, the left-middle line represents the low mid frequency output level, 
the right-middle line represents the high mid frequency output level, and 
the line to the right represents the high frequency output level. Use the 
bottom section of the control panel to adjust crossover settings. The low 
mid and high mid sections include type and frequency settings for both 
ends of these curves.

Link

Press the Link button between the low and low mid groups to lock the low 
pass and low mid high pass frequencies to the same number. Press the 
Link button between the low mid and high mid groups to lock the low mid 
low pass and high mid high pass frequencies to the same number. Press 
the Link button between the high mid and high groups to lock the high 
mid low pass and high pass frequencies to the same number. Linking is 
only an option when both types are set to Butterworth or Linkwitz-Riley. If 
link is off, the frequencies can be adjusted independently.
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1/3 Oct Graphic EQ

Figure 7.8 - 1/3 Oct Graphic EQ

The 1/3 octave graphic equalizer boosts or cuts output level at 31 different 
frequencies from 20 Hz to 20 kHz. Double-click on the 1/3 Oct Graphic 
EQ block to open the control panel.

Figure 7.9 - 1/3 Oct Graphic EQ control panel
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Adjust the gain slider at each frequency to boost or cut the level from -15 
dB to 15 dB. Type in a boost or cut value in the fields below each slider to 
set the gain. 
Press the Flatten All button to return all sliders to 0.0. 
Press the Bypass button to bypass all equalizer settings.

Tone control EQ

Figure 7.10 - Tone control EQ

The Tone control EQ boosts or cuts output level at the low, mid and high 
bandwidths. Double-click on the Tone control EQ block to open the 
control panel.
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Figure 7.11 - Tone control EQ control panel

Adjust the gain slider at each bandwidth to boost or cut the level from -15 
dB to 15 dB. You can also type in a boost or cut value in the fields above 
each slider to set the gain. 
Press the Bypass button under a gain slider to bypass the gain 
adjustment for the bandwidth.
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Parametric EQ

Figure 7.12 - Parametric EQs

The Parametric EQ allows you to adjust the equalization curve for an 
input signal at multiple filter bands according to center frequency, type of 
filter, amount of cut or boost (gain) and width of frequency range affected 
by each filter band (Q/BW). There are four different types of Parametric 
EQ’s: 3 band, 5 band, 7 band, and 9 band. The control panels differ only 
in the amount of bands available for boost or cut. Double-click on a 
Parametric EQ block to open the control panel. The 5 band Parametric 
EQ control panel is shown below.
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Figure 7.13 - 5 band Parametric EQ control panel

The left side of the control panel is a graphical representation of the 
equalization curve. The dark line represents the EQ curve and the blue 
boxes represent the center frequency of each filter band. When you first 
open the control panel, the center frequencies are all set at 1000 Hz, so 
the blue boxes are all at the same point. You can adjust the center 
frequency and gain for each filter band by dragging the blue box with your 
mouse in the left side of the control panel.

Figure 7.14 - Drag the blue boxes to set frequency and gain

The right side of the control panel shows settings for each filter band.
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Type

PEQ Boosts and cuts the signal in the vicinity of the specified 
frequency.

          

High Shelf Boosts and cuts the signal above the specified frequency.

            

Low Shelf Boosts and cuts the signal below the specified frequency.

            

Notch Attenuates the signal at the specified frequency.
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Frequency
The center frequency of the filter band, in Hz, from 20 to 20,000 Hz.

Q or BW
The bandwidth that is affected by the filter. Only available when using 
PEQ and Notch type filters. Q is the ratio of the center frequency divided 
by the bandwidth. Press the Q/BW button to toggle between the two unit 
systems.

Gain
The amount of cut or boost to the signal in dB, from -20 to 20. Only 
available when using PEQ, High Shelf, and Low Shelf type filters. When 
using Low Pass and High Pass filters, this field is used to adjust the 
slope of the attenuation curve (-6 dB/Oct, or -12 dB/Oct).

Bypass
Use the Bypass buttons to bypass a given filter. Use the Bypass All 
button to turn on or off all bypass buttons.

Low Pass Attenuates the signal above the specified frequency.

High Pass Attenuates the signal below the specified frequency.
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Sort
Press the Sort button to sort the filters from lowest to highest center 
frequency.

Storing and saving equalization settings
Use the Store button to store the current EQ settings. The settings are 
stored as a “snapshot”, and can be recalled using the dropdown menu. 
Press the Delete button to delete a snapshot. Select Default Setting to 
clear any changes you have made.

Figure 7.15 - Store and recall EQ curve snapshots

Snapshots are available only within the Parametric EQ block that you are 
currently working with. To make settings available to other Parametric EQ 
blocks, as well as for other ControlSpace projects, press the Save 
Settings button to save your settings as a .peq file on your hard drive. 

Figure 7.16 - Save settings

To load these settings into another Parametric EQ block, open the block’s 
control panel, and press the Load Settings button. Choose the saved 
.peq file that you want to load.
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Speaker EQ
Use a speaker EQ block to apply Bose equalization settings to Bose 
loudspeakers. Four types of EQ blocks are available: a single 
loudspeaker, a two-output speaker EQ with crossover, and two bass array 
blocks.

Single Speaker 

Figure 7.17 - Single Speaker EQ

The Single Speaker EQ block applies the appropriate equalization the 
input signal for the selected Bose loudspeaker. To choose a setting, 
double-click on the Single Speaker EQ block to open the control panel.
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Figure 7.18 - Single Speaker EQ control panel

The following speaker EQ settings are available:

402II 402® Series II loudspeaker Full Range EQ

402II HF 402 Series II loudspeaker bi-amped @180Hz

502A 502®A loudspeaker Full Range EQ

502A HF 502A loudspeaker bi-amped @160Hz

802III 802® Series III loudspeaker Full Range EQ

802III HF 802 Series III loudspeaker bi-amped @125Hz

802III STK Stacked 802 Series III loudspeaker EQ

802III STK HF Stacked 802 Series III loudspeaker bi-amped @125Hz

MA12 WALL MA12 loudspeaker Full Range Wall Mount EQ Curve

MA12 FREE MA12 loudspeaker Full Range Free Field EQ Curve

MA12 HF MA12 loudspeaker bi-amped @160Hz

MA12 STK WALL Stacked MA12 loudspeaker Full Range Wall Mount EQ 
Curve

MA12 STK FREE Stacked MA12 loudspeaker Full Range Free Field EQ 
Curve
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MA12 STK HF Stacked MA12 loudspeaker bi-amped @160Hz

MB4 100Hz LP MB4 loudspeaker Low Pass @ 100Hz

MB4 160Hz LP MB4 loudspeaker Low Pass @ 160Hz 

MB4 200Hz LP MB4 loudspeaker Low Pass @ 200Hz 

MB4 280Hz LP MB4 loudspeaker Low Pass @ 280Hz

MB24 100Hz LP LT MB24 loudspeaker Low Pass @ 100Hz 

MB24 160Hz LP LT MB24 loudspeaker Low Pass @ 160Hz 

MB24 200Hz LP LT MB24 loudspeaker Low Pass @ 200Hz 

MB24 280Hz LP LT MB24 loudspeaker Low Pass @ 280Hz 

502B 502®B loudspeaker Low Pass @ 160 Hz

502BEX 502BEX loudspeaker Low Pass @ 200 Hz

AWCS Acoustic Wave® Cannon System II

LT3202 LT3202® loudspeaker Full Range EQ

LT3202CLUSTER LT3202 loudspeaker Cluster EQ

LT4402 LT4402® loudspeaker Full Range EQ

LT4402CLUSTER LT4402 Cluster EQ

LT9402 LT9402™ loudspeaker Full Range EQ

LT9402CLUSTER LT9402 Cluster EQ

LT9702 LT9702® loudspeaker Full Range EQ

LT9702CLUSTER LT9702 Cluster EQ

M8 Model 8 loudspeaker Full Range EQ

M16 Model 16 loudspeaker Full Range EQ

M32 Model 32 loudspeaker Full Range EQ

FS1B 100Hz LP FreeSpace® Model 1B loudspeaker Low Pass @ 
100Hz
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Crossover + Speaker EQ

Figure 7.19 - Cross + Speaker 

The crossover plus speaker EQ block is used when a signal is sent to a 
pair of low frequency and high frequency Bose loudspeakers. The Cross 
+ Speaker block applies equalization to the input signal and splits the 
signal into low and high outputs. To choose a speaker combination, 
double-click on the Cross + Speaker EQ block to open the control panel.

FS1B SURFACE FreeSpace® Model 1B loudspeaker Surface Mount EQ

FS1B FLUSH FreeSpace Model 1B loudspeaker Flush Mount EQ

FS3B 100Hz LP FreeSpace 3 Bass Low Pass @ 100Hz

FS3B 150Hz LP FreeSpace 3 Bass Low Pass @ 150Hz

LT9403 LT9403 loudspeaker Full Range EQ

LT6403 LT6403 loudspeaker Full Range EQ

Flat Flat EQ
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Figure 7.20 - Cross + Speaker control panel

The following high and low frequency loudspeaker EQ combinations are 
available:

402II+502B 402® Series II loudspeaker bi-amped with 502®B 
loudspeaker

402II+502BEX 402 Series II loudspeaker bi-amped with 502BEX 
loudspeaker

402II+MB4 402 Series II loudspeaker bi-amped with MB4

402II+AWCS 402 Series II loudspeaker bi-amped with AWCS

502A+502B 502®A loudspeaker bi-amped with 502B

502A+MB4 502A loudspeaker bi-amped with MB4

502A+AWCS 502A loudspeaker bi-amped with AWCS

802III+502B 802® Series III loudspeaker bi-amped with 502B

802III+502BEX 802 Series III loudspeaker bi-amped with 502BEX

802III+MB4 802 Series III loudspeaker bi-amped with MB4

802III+AWCS 802 Series III loudspeaker bi-amped with AWCS

802IIIST+502B Stacked 802 Series III loudspeakers bi-amped with 502B
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802IIIST+502X Stacked 802® Series III loudspeakers bi-amped with 
502®BEX

802IIISTK+MB4 Stacked 802 Series III loudspeakers bi-amped with MB4

802IIISTK+AWCS Stacked 802 Series III loudspeakers bi-amped with AWCS

MA12+502B MA12 loudspeaker bi-amped with 502B

MA12+MB4 MA12 loudspeaker bi-amped with MB4

MA12STK+502B Stacked MA12 loudspeaker bi-amped with 502B

MA12STK+MB4 Stacked MA12 loudspeaker bi-amped with MB4

LT3202+MB4 LT3202® loudspeaker bi-amped with MB4

LT3202+MB24 LT3202 loudspeaker bi-amped with MB24

LT4402+MB4 LT4402® loudspeaker bi-amped with MB4

LT4402+MB24 LT4402 loudspeaker bi-amped with MB24

LT9402+MB4 LT9402™ loudspeaker bi-amped with MB4

LT9402+MB24 LT9402 loudspeaker bi-amped with MB24

LT9402+502BEX LT9402 loudspeaker bi-amped with 502BEX

LT9702+MB4 LT9702® loudspeaker bi-amped with MB4

LT9702+MB24 LT9702 loudspeaker bi-amped with MB24

LT9702+502BEX LT9702 loudspeaker bi-amped with 502BEX

M8+MB4 Model 8 loudspeaker bi-amped with MB4

M8+FS3B Model 8 loudspeaker bi-amped with FS3B

M8+FS1B Model 8 loudspeaker bi-amped with FS1B

M16+FS3B Model 16 loudspeaker bi-amped with FS3B

M32+MB4 Model 32 loudspeaker bi-amped with MB4

M32+FS3B Model 32 loudspeaker bi-amped with FS3B

M32+FS1B Model 32 loudspeaker bi-amped with FS1B
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2 Bass Array

Figure 7.21 - 2 Bass Array

The 2 output bass array block is used to create two loudspeaker end-fire 
and broad-fire bass arrays using two MB4 loudspeakers. This block sets 
the EQ and delay required when using this bass array. To choose a 
configuration, double-click on the 2 Bass Array block to open the control 
panel.

M32+502BEX Model 32 loudspeaker bi-amped with 502BEX
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Figure 7.22 - 2 Bass Array control panel

MB4 2x EF180Hz MB4 2x Endfire Bass Array, 180Hz crossover.

The MB4 2x Endfire Bass Array preset provides 180 
degree conical dispersion @ 160Hz. The crossover is 
set at 180Hz and is recommended for use with MA12, 
MB4 and 02 Series speakers.

An MB4 2x Endfire Bass array uses two MB4 
loudspeakers spaced 23 inches (58.4 cm) on center 
from each other.

MB4 2x EF280Hz MB4 2x Endfire Bass Array, 280Hz crossover.

The MB4 2x Endfire Bass Array preset provides 180 
degree conical dispersion @ 160Hz. The crossover is 
set at 280Hz and is recommended for use with MA12, 
MB4 and LT Series speakers.

An MB4 2x Endfire Bass array uses two MB4 
loudspeakers spaced 23 inches (58.4 cm) on center 
from each other.
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MB4 2x BS180Hz MB4 2x Broadside Bass Array, 180Hz crossover.

The MB4 2x Broadside Bass Array preset provides 
360 degree horizontal coverage with a 10 to 15 dB 
suppression in energy going up and down from 80 – 
200Hz. The crossover is set at 180Hz and is 
recommended for use with MA12, MB4 and 02 Series 
speakers.

An MB4 2x Broadside Bass array uses two MB4 
loudspeakers spaced 45 inches (114.3 cm) on center 
from each other.

MB4 2x BS280Hz MB4 2x Broadside Bass Array, 280Hz crossover.

The MB4 2x Broadside Bass Array preset provides 
360 degree horizontal coverage with a 10 to 15 dB 
suppression in energy going up and down from 80 – 
200Hz. The crossover is set at 280Hz and is 
recommended for use with the LT Series.

An MB4 2x Broadside Bass array uses two MB4 
loudspeakers spaced 45 inches (114.3 cm) on center 
from each other.
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4 Bass Array

Figure 7.23 - 4 Bass Array

The 4 output bass array block is used to create four loudspeaker end-fire 
bass arrays using four MB4 loudspeakers. This block sets the EQ and 
delay needed when using this bass array. To choose a configuration, 
double-click on the 4 Bass Array block to open the control panel.

Figure 7.24 - 4 Bass Array control panel
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MB4 4x EF280Hz MB4 4x Endfire Bass Array, 280Hz 
crossover.

The MB4 4x Endfire Bass Array preset 
provides 120 degree conical dispersion
@ 160Hz. The crossover is set at 280Hz
and is recommended for use with MA12, 
MB4 and LT Series speakers.

An MB4 4x Endfire Bass array uses four 
MB4 loudspeakers spaced 29 inches 
(73.6 cm) on center from each other.

MB4 4x EF180Hz MB4 4x Endfire Bass Array, 180Hz 
crossover.

The MB4 4x Endfire Bass Array preset 
provides 120 degree conical dispersion 
@ 160Hz. The crossover is set at 180Hz 
and is recommended for use with MA12, 
MB4 and 02 Series speakers.

An MB4 4x Endfire Bass array uses four 
MB4 loudspeakers spaced 29 inches 
(73.6 cm) on center from each other.
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Routers

Figure 7.25 - Routers

Routers provide simple in/out routing of signals. An input signal can be 
routed to multiple output channels, but an output channel cannot accept 
more than one input signal. An output channel can also be turned off. 
Routers are named according to the number of input and output channels 
they provide. You can use 4X4, 4X8, 8X4, 8X16, and 16X8 routers. To 
open a router control panel, double-click on the Router block. The 4X4 
Router control panel is shown below.
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Figure 7.26 - 4X4 Router control panel

To route a given input signal to an output, press the button underneath the 
output number. To turn the output off, press the button in the OFF row. 
You can also rename any input or output channel by typing in the fields to 
the left and bottom of the control panel.

Figure 7.27 - A stereo input routed to four different outputs
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Gain

Figure 7.28 - Gain

Gain blocks control the signal level. Double-click the gain block to open 
the gain control panel.

Figure 7.29 - Gain control panel
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Use the slider to adjust the gain, or type a gain value into the field at the 
top of the control panel. Gain can be set between - infinity and + 12 dB. 
Press the Mute button to mute the signal output.

Delay

Figure 7.30 - Delay blocks

Delay blocks are available with one, two, four and eight outputs. A delay 
can be imparted on each output signal independently. To open a delay 
control panel, double-click on the delay block. A four output delay control 
panel is shown below.

Figure 7.31 - 4 out delay control panel
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Use the Units dropdown menu to set the delay units:
•    0 - 3000 milliseconds
•    0 - 144000 samples
•    0 - 1104.3 meters
•    0 - 1104300 millimeters
•    0 - 3623.031 feet
•    0 - 43476.378 inches. 

Each output delay can be set independently. Press the Bypass button to 
bypass the delay.

Standard Mixer

Figure 7.32 - Standard Mixers

Standard mixers are used to route input and output signals, and to adjust 
the input and output signal levels. Standard mixers are named according 
to the number of input and output channels they provide. You can use 
2X1, 8X8, 16X8, 16X24, 24X16, and 24X24 standard mixers. To open a 
standard mixer control panel, double-click on the standard mixer block. 
The 8X8 standard mixer control panel is shown below.
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Figure 7.33 - 8X8 standard mixer control panel

Inputs are displayed in green and outputs are displayed in orange. To 
route a green input channel to an orange output channel, click the assign 
button at the intersection of the two channels. The button turns blue after 
being assigned. Click the button again to remove the assignment.

Figure 7.34 - Press the assign buttons to route inputs to outputs

Mute an input or output by pressing the Mute buttons to the left of the 
inputs, and above the outputs. The input and output level can be adjusted 
by typing in a gain value between -60 and 12 dB in the field next to the 
input/output channel number.
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Figure 7.35 - Adjust input and output levels

Assigning several inputs to one output results in a summed output signal.

Matrix mixer

Figure 7.36 - Matrix mixers
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Like the standard mixer, matrix mixers are used to route inputs to outputs, 
but have the added ability to adjust the signal level at each routing 
juncture. Matrix mixers are named according to the number of input and 
output channels they provide. 4X4, 8X8, and 16X16 matrix mixers are 
available. The 4X4 matrix mixer control panel is shown below.

Figure 7.37 - 4X4 matrix mixer control panel

To route an input channel to an output channel, click the assign button at 
the intersection of the two channels. The button turns blue indicating it 
has been assigned. Click the button again to remove the assignment of 
the input to the particular output. To adjust the signal level at the routing 
juncture, right click on the button and adjust the gain slider. Gain can be 
set between - infinity and 0.0 dB.

Figure 7.38 - Right click on an assign button to adjust gain
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Room Combining Mixer

Figure 7.39 - Room combining Mixer

The room combining mixer is used to mix and route local and global 
inputs to one, two, three, or four separate rooms. When adjacent rooms 
are connected together, or “combined”, the same audio is routed to both 
rooms. For example, a hotel ballroom may have three “air walls” that can 
be used to divide the rooms into 4 smaller rooms, or many other 
combinations, like 2 medium sized rooms. The room combining mixer has 
four local inputs and four global inputs. The local inputs are located in 
each separate room, for example, each room might have a microphone 
jack input. The global inputs are for sources that span all rooms, for 
example, background music. 
To open the room combining mixer control panel, double-click on the 
block.
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Figure 7.40 - Room combining mixer control panel

The room combining mixer control panel consists of four sections which 
correspond to the separate rooms in your design (you can have up to four 
rooms). Each section includes a local input gain slider, and a global input 
gain slider. Select the global input source for each room using the 
dropdown menu above the global gain slider.

Combining rooms
To combine rooms, press the Combine button located between the 
rooms that you want to combine.

Figure 7.41 - Combining rooms 1 and 2
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When the rooms are combined, only one of the local inputs is allowed. 
Notice that when rooms one and two are combined, the gain sliders and 
global input dropdown menus are disabled for room 2. Place a checkmark 
next to Local Select in the room for which you want the local input to be 
active. To combine more than two rooms, press the Combine button 
between the rooms you want to combine.
The output signal for each room is the mix of local input and the selected 
global input. If you do not want to mix in either the local or global input, 
lower the input gain to -infinity. The following examples show the input 
configurations for three different room combining scenarios:

Figure 7.42 - Four independent rooms

Figure 7.43 - Rooms 1 and 2 combined

Output for 
Room:

Local input: Global input:

1 is a mix of 1 and 1, 2, 3, or 4

2 is a mix of 2 and 1, 2, 3, or 4

3 is a mix of 3 and 1, 2, 3, or 4

4 is a mix of 4 and 1, 2, 3, or 4

Output for 
Room:

Local input: Global input:

1, 2 is a mix of 1 or 2 and 1, 2, 3, or 4

3 is a mix of 3 and 1, 2, 3, or 4

4 is a mix of 4 and 1, 2, 3, or 4
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Figure 7.44 - Rooms 1, 2, and 3 combined:

Signal Generator

Figure 7.45 - SGenerator

ControlSpace Designer software includes three signal generator blocks: a 
sine wave generator, a noise generator, and a sweep generator. To open 
a signal generator control panel, double-click on the signal generator 
block.

Output for 
Room:

Local input: Global input:

1, 2, 3 is a mix of 1 or 2 or 3 and 1, 2, 3, or 4

4 is a mix of 4 and 1, 2, 3, or 4
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Sine wave generator

Figure 7.46 - Sine wave generator control panel

The sine wave generator produces frequencies from 20 to 20 kHz. Use 
the field at the bottom of the control panel to specify the output frequency. 
Control the signal level by using the gain slider, or by typing in a decibel 
value between - infinity and +12 dB in the field above the slider. Press the 
Mute button to mute the output signal.
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Noise generator

Figure 7.47 - Noise generator control panel

The noise generator will produce Pink noise or White noise. Select the 
type of noise from the dropdown menu at the bottom of the control panel. 
Control the signal level by using the gain slider, or by typing in a decibel 
value between - infinity and +12 dB in the field above the slider. Press the 
Mute button to mute the output signal.
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Sweep generator

Figure 7.48 - Sweep generator control panel

The sweep generator produces a sweep sine signal from 20 Hz to 20 
kHz. To start the signal, press the Start button at the bottom of the control 
panel. Press this button again to stop the sweep signal. Choose a fast or 
slow sweep using the dropdown menu below the gain slider. Control the 
signal level by using the gain slider, or by typing in a decibel value 
between - infinity and +12 dB in the field above the slider.
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Meters

Figure 7.49 - Meters

Meter blocks display a bar level meter which displays signal level. There 
are three meter blocks available: 4 input, 8 input, and 16 input. The 4 
input meter control panel is shown below.

Figure 7.50 - 4 input meter control panel
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The meter control panel displays signal level in dBFS. Press the Peak 
Hold button to turn on a persistent line indicating the highest signal level.

Compressor/Limiter

Figure 7.51 - Compressor/Limiter

The Compressor/Limiter blocks dynamically reduce the level of an input 
signal above a certain threshold. ControlSpace Designer software 
includes a monaural Compressor/Limiter with one input and a side chain 
input, and a stereo Compressor/Limiter with stereo inputs and a side 
chain input. The control panels differ only in the choice of input signal 
used as the trigger signal. The stereo Compressor/Limiter control panel is 
shown below.
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Figure 7.52 - Stereo Compressor/Limiter control panel

Use the four sliders on the left side to adjust the Threshold, Ratio, 
Attack, and Release. The graph on the right side of the control panel 
shows the input level versus the output level, and the slope of the line 
indicates the compression ratio. The Reduction meter shows the 
reduction in gain caused by compression. Press the Bypass button to 
bypass the Compressor/Limiter. 
Use the Detector dropdown menu to choose which input acts as the 
trigger source. Select Mix in the stereo Compressor/Limiter to use both 
the L and R inputs as the trigger source.
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Duckers

Figure 7.53 - Duckers

A ducker lowers the output volume upon the detection of a side chain 
input signal. A typical example is background music that is interrupted by 
a microphone page. When the ducker senses the microphone signal in 
the side chain input, it automatically lowers the background music signal 
level at the output. There are two duckers available in ControlSpace 
Designer software: monaural, which accepts one input and one side chain 
input, and stereo, which accepts a stereo input and a side chain input. 
The control panel is the same for each ducker. Double-click on a ducker 
block to open the control panel.
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Figure 7.54 - Ducker control panel

Use the sliders on the left side to adjust the Threshold, Range, Attack, 
Hold and Decay. The Range setting dictates the amount of reduction in 
volume when the ducker is active. The graph on the right side of the 
control panel shows the input level versus the output level of the signal. 
The Reduction meter shows the reduction in gain of the output signal. 
Press the Bypass button to bypass the ducker.

Note: The side chain input signal is not passed to the ducker output, it is 
only used as a trigger signal. If you want the source that is used for 
the trigger to be heard, you will need to mix it back in to the output 
after the ducker. For example, in the background music/microphone 
announcement example above, the microphone signal will need to 
be mixed back in after the ducker in order to hear the 
announcement.
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AGC

Figure 7.55 - AGC

Automatic Gain Control (AGC) combines a compressor and a gate to 
maintain a constant output signal level with varying input signal levels. For 
example, if two speakers use the same microphone, an AGC can keep 
the output volume at one level. Both monaural and stereo AGCs are 
available. The control panels differ only in the choice of input signal used 
as the trigger signal. To open the AGC control panel, double-click on the 
AGC block.
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Figure 7.56 - Stereo AGC control panel

The AGC control panel includes a Threshold slider and Reduction meter. 
Use the Threshold slider to adjust the output level. The Reduction meter 
shows the reduction in gain of the output signal. In the stereo AGC control 
panel, use the Detector dropdown menu to choose which input acts as 
the trigger source. Select Mix to use both the L and R inputs as the trigger 
source. Press the Bypass button to bypass the AGC.
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Gate

Figure 7.57 - Gate

The gate block attenuates a signal that is below a certain threshold. This 
is useful in situations where you want to cut out sounds below a certain 
volume. For example, if a microphone is located in a noisy area, you 
could put a gate on the signal so that sounds that are quieter than the 
speaker’s voice are not heard. There are both monaural and stereo gates 
available in ControlSpace Designer software. The control panels differ 
only in the choice of input signal used as the trigger signal. Double-click a 
gate block to open the control panel.
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Figure 7.58 - Gate control panel

Use the four sliders on the left side to adjust the Threshold, Range, 
Attack, Hold and Decay. The graph on the right side of the control panel 
shows the input level versus the output level, and the line indicates the 
effect of the gate. Use the Detector dropdown menu to choose which 
input acts as the trigger source. Select Mix in the stereo gate to use both 
the L and R inputs as the trigger source. Press the Bypass button to 
bypass the gate.
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Source Selector

Figure 7.59 - Source Selector

Source selectors pass one of their input signals to the output channel. 
Both monaural and stereo source selectors are available. Four monaural 
source selectors are available. 4, 8 and 16 channel stereo source 
selectors are available. Double-click on a source selector to open the 
control panel. The 4 channel stereo source selector control panel is 
shown below.

Figure 7.60 - 4 channel stereo source selector control panel
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Use the dropdown menu to select an input channel. Double-click in the 
Name column to rename a channel.

Figure 7.61 - Rename inputs

Note that as you select different channels, the selector bar on the signal 
processing block indicates your selection.

Figure 7.62 - Selector bar
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Chapter 8: Menu and Toolbar reference

Menu reference

File menu

New Create a new project file (.csp). If a project is currently open, 
and unsaved you will be prompted to save it before creating a 
new project.

Open Open an existing project by locating it on the hard drive and 
choosing the .csp file. If a project is currently open with 
unsaved changes, you will be prompted to save it before 
opening a new project.

Save Save changes to the project. If you have not yet saved the 
project, you will be prompted to name and save the project.
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Save As... Create a copy of the project and save it with a different name. 
The new saved project will remain open and the original project 
will be closed.

Export ... Export the contents of your project to a comma delimited (.csv) 
file. This file contains the entire tree structure of your project, 
similar to the Project Directory window.

Project 
Information

Open the Project Information window, where you can record 
contact information and comments related to the design.
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Page Setup Open the Page Setup window, where you can change the 
Paper Size, printer paper source, orientation, and margin 
sizes.

Print Preview ... Open the Print Preview window to view what your design will 
look like when printed.
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Print ... Open the Print window to select a printer, specify which pages 
to print, and specify a number of copies to print.

Recent Files Open one of up to four recently loaded project files. 

Exit Close ControlSpace Designer software.
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Edit menu

Cut Delete the selected item and copy to the clipboard (standard 
Windows editing function).

Copy Copy the item to the clipboard (standard Windows editing 
function).

Paste Paste the contents of the clipboard (standard Windows editing 
function).

Copy Parameters Copy the parameters, or settings, for a signal processing block 
in the ESP-88 window. The parameters can be copied to 
another signal processing block of the same type.

Paste Parameters Paste the copied settings from one signal processing block to 
one or more other blocks of the same type.

Delete Delete the selected item.

Select All Select all items in the active window.
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View menu

Align Left Sides Align the left sides of all selected signal processing blocks in 
Project View or the ESP-88 window.

Align Horizontal 
Centers

Align the horizontal centers of all selected signal processing 
blocks in Project View or the ESP-88 window.

Align Right Sides Align the right sides of all selected signal processing blocks in 
Project View or the ESP-88 window.

Align Tops Align the tops of all selected signal processing blocks in 
Project View or the ESP-88 window.

Align Vertical 
Centers

Align the vertical centers of all selected signal processing 
blocks in Project View or the ESP-88 window.

Align Bottoms Align the bottoms of all selected signal processing blocks in 
Project View or the ESP-88 window.

Zoom In Magnify your view in Project View, or the ESP-88 window.

Zoom Out Display a larger area of your view in Project View, or the ESP-
88 window.

Zoom Normal Set the zoom level to 100%.
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Zoom To Fit Set the zoom level so that all objects can be seen in Project 
View, or the ESP-88 window.

Show Grid Switch the background grid in Project View, or the ESP-88 
window between two different patterns, or no grid.

Hidden Wires 
mode

Toggle the wiring between show and hide.

Overview Open the Overview window. The Overview window contains a 
high level view of your signal processing design in the ESP-88 
window. Use your mouse cursor to draw a box around an area 
of your design that you would like to zoom in on.

Use the mouse to drag the zoom window around your design.

The overview window can be kept open while making changes 
to your designs.
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Tools menu

Set Temperature Open the Temperature window to set the ambient temperature 
for which you would like to calculate delay times, in degrees 
Fahrenheit, or degrees Celsius. Alternately you can set the 
speed of sound at your design location in ft/s or m/s. 
ControlSpace Designer software uses this value to calculate 
loudspeaker delay times.
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Set Main ESP ... Open the Set Main ESP window. In a design with multiple 
ESP-88s, use this window to specify which ESP-88 is the Real 
Time Clock (RTC) for your system. Only one ESP-88 can act 
as the RTC unit.

DSP Resources Open the DSP Resources window to view the percent capacity 
used for signal processing (DSP) and delay in the selected 
ESP-88.
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Go on-line /       
Go off-line

When connected to the ControlSpace hardware, go on-line to 
upload your system design, or download from the hardware, 
and to adjust settings in real time. The background in Project 
View, and the ESP-88 window turn blue to indicate that you are 
now working online.

When you are online, press the Go off-line button to 
disconnect.

Scan Use the Scan feature to detect hardware on your local network. 
Do not press the Scan button while you have an existing 
project open. This may result in a conflict that can cause a 
change in your system design configuration. Scan should be 
used with a blank new project only, as a means to identify what 
hardware exists on the local network. When ControlSpace 
Designer software completes the scan, the Project View is 
automatically populated with the ESP-88s, CC-64s, and CC-
16s that are properly connected in your local network.

System Mute Mute all audio output when working online.
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System menu

Update Firmware Open the Update Firmware window. While connected to the 
ControlSpace hardware, you can view the version of the 
currently loaded firmware and update the firmware for the CC-
64(s), ESP-88(s) and CC-16(s) on your local network.
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Window menu

Network Setup Open the Network Setup window to view and change the IP 
address of a component on your system.

Device List/SP 
Tool Kit

When working in Project View, toggle the Device List window 
between show and hide. When working in the ESP-88 window, 
toggle the SP Tool Kit window between show and hide.

Project Directory Toggle the Project Directory window between show and hide.
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Help menu

Presets Toggle the Presets window between show and hide.

Parameter Sets Toggle the Parameter Sets window between show and hide.

Groups Toggle the Groups window between show and hide.

Timer Toggle the Timer window between show and hide.

Scan Toggle the Scan window between show and hide.

Hide All Close all windows except Project View and the ESP-88 
window.

Set to default 
positions

Return all open windows to their default location in 
ControlSpace Designer software.

Help Topics ... Open the HTML Help file.

About 
ControlSpace 
Designer

Open the About ControlSpace Designer software window.
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Toolbar reference

Main toolbar

New Project
(Ctrl+N)

Create a new project file (.csp). If a project is currently open, 
you will be prompted to save it before creating a new project.

Open Project
(Ctrl+O)

Open an existing project by locating it on the hard drive and 
choosing the .csp file. If a project is currently open with 
unsaved changes, you will be prompted to save it before 
opening a new project.

Save File
(Ctrl+S)

Save changes to the project. If you have not yet saved the 
project, you will be prompted to name and save the project.

Cut
(Ctrl+X)

Delete the selected item and copy to the clipboard (standard 
Windows editing function).
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Copy
(Ctrl+C)

Copy the item to the clipboard (standard Windows editing 
function). 

Paste
(Ctrl+V)

Paste the contents of the clipboard (standard Windows editing 
function).

Zoom In
(Ctrl+1)

Magnify your view in Project View, or the ESP-88 window.

Zoom Out
(Ctrl+2)

Display a larger area of your view in Project View, or the ESP-
88 window.

Select a Zoom percentage from the dropdown menu, or type in 
a zoom percentage.

Show Grid Switch the background grid in Project View, or the ESP-88 
window between two different patterns, or no grid.

Hidden Wires 
Mode

Toggle the wiring between show and hide.
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Go on-line / Go 
off-line

     

When connected to the ControlSpace hardware, use go on-line 
to upload your system design, and to adjust settings in real 
time. The background in Project View, and the ESP-88 
window turn blue to indicate that you are now working online.

When you are online, press the Go off-line button to 
disconnect.

Scan Use the Scan feature to detect hardware on your local network. 
Do not press the Scan button while you have an existing 
project open. This may result in a conflict that can cause a 
change in your system design configuration. Scan should be 
used with a blank new project only, as a means to identify what 
hardware exists on the local network. When ControlSpace 
Designer software completes the scan, the Project View is 
automatically populated with the ESP-88s, CC-64s, and CC-
16s that are properly connected in your local network. 

System Mute

    

Mute all audio output when working online.
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DSP Resources Open the DSP Resources window to view the percent capacity 
used for signal processing (DSP) and delay in the selected 
ESP-88.
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Index

A
AGC, 184
Align signal processing blocks, 48
Audio Cards, 39
Audio indicator lights, 42

B
Blue background, 52

C
CC-16

Labels, 110
Locking, 107
Overview, 103
Programming, 104
Properties, 109
Volume properties, 106

CC-64
Custom settings, 94
IP address properties, 102
Labels, 100
Locking, 97
Overview, 88
Programming, 90
Properties, 99
Volume properties, 96

Compressor/Limiter, 180
Control Library, 26, 31, 57
Copy/Paste Parameters, 43, 49, 195

D
Delay, 167
Device List, 20, 36
Downloading project files, 35, 53

DSP Resources, 50, 199
Duckers, 182

E
ESP-88 properties, 39
ESP-88 window, 22, 40

Inputs, 41
Outputs, 44

Ethernet crossover cable, 1
Ethernet hub, 1
Exporting, 192

F
Firmware files, 15
Firmware update

Latest version, 16
Loaded version, 16
Re-boot ESP-88, 17

Firmware update window, 15
Flash memory, 14, 51

G
Gain, 166
Gate, 186
Go off-line, 33, 55
Go on-line, 33, 51
GPI - General Purpose Inputs, 46

Control panel, 114
Digital Up/Down, 123
Discrete mode, 120
Operating modes, 115
Programming, 115
Set Mode, 118
Testing, 124
Using a potentiometer, 121
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Volume settings, 122
GPIO expansion card, 113, 125
GPO - General Purpose Outputs, 46, 125

Programming, 126
Groups, 57

Add Group, 63
Add To Group, 64
Clear, 62
Group Nodes List, 65
Master Fader, 60
Rename, 60

H
Hidden Wires mode, 197

I
IP addresses, 7

Change IP address, 8
Multiple CC-64s, 9
Multiple ESP-88s, 8

L
Local Area Connection Properties, 6
Local network

Ethernet hub, 1

M
Matrix mixer, 170
Meters, 179
Microsoft® .NET™ Framework, i

N
Network Setup window, 14

O
Output node symbols, 44
Overview, 197

P
Parameter Sets, 57, 67

Add To Parameter Set, 70
Clearing, 74
Creating, 67
Parameter Set Nodes List, 71
Recalling, 74
Rename, 69

Parametric EQ, 148
Paste Parameters, 49, 195
Presets, 57, 74

Changing, 77
Clearing, 77
Creating, 75
Recalling, 76
Rename, 76

Project Directory, 84, 132
Project files, 35
Project files (.csp), 35
Project View, 20, 36

Wiring, 36

Q
Quick launch icon, iii

R
Real-time controls, 52
Renaming, 37
Room Combining Mixer, 172
Routers, 164
RTC - Real Time Clock, 37
Running settings, 54
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S
Saved settings, 54
Scan button, 12, 53
Serial Inputs, 46

Strings, 129
Serial Outputs, 46

Programming, 130
Serial port, 128
Set Main ESP, 199
Set Temperature, 198
Show Grid, 197
Signal Generator, 175
Smart Simulators, 27, 32

CC-16, 104
CC-64, 89

Source Selector, 188
SP Tool Kit, 22, 23, 25, 47
Speaker EQ, 153

2 Bass Array, 159
4 Bass Array, 162
Crossover + Speaker EQ, 156
Single Speaker, 153

Standard Mixer, 168
Step size, 97, 107
System Requirements, i

T
Timers, 57, 78

Add To Timer, 81
Clearing, 83
Creating, 78
Recalling, 83
RTC, 83
Timer Setup, 80

Tone control EQ, 146

U
Upload design, 51

W
Wiring, 22

Delete, 38
Move, 38

Numerics
1/3 Oct Graphic EQ, 145
2 way crossover, 138
3 way crossover, 141
4 way crossover, 143
Index                                                       211


	Contents
	Introduction
	System Requirements
	Install ControlSpace Designer software
	Launch ControlSpace Designer software

	Chapter 1 : Configure the ControlSpace Designer network
	Ethernet connections
	Connect to one ESP-88
	Connect to multiple ESP-88s and CC-64s using an Ethernet hub
	Change your computer’s network settings


	IP addresses
	Use more than one ESP-88
	Use more than one CC-64
	Use scan
	Network setup

	Device firmware
	Update firmware


	Chapter 2 : The ControlSpace Designer Software Interface
	ControlSpace Designer software windows
	Project View
	ESP-88 window
	Input blocks

	Signal Processing (SP) Tool Kit
	Control Library windows
	Smart Simulators

	ControlSpace workflow
	Step 1: Build and connect the components of your system in the Project View
	Step 2: Configure the signal processing in the ESP-88
	Step 3: Store the system programming
	Step 4: Program user controls
	Step 5: Go online
	Final Step: Disconnect


	Chapter 3 : Build a ControlSpace ESP-88 system
	Build a system design
	Project files
	Project View
	ESP-88 properties

	ESP-88 window
	Card inputs
	Card Outputs
	General Purpose Inputs (GPI) and General Purpose Outputs (GPO)
	Serial Inputs, Serial Outputs

	Add signal processing
	Working with signal processing blocks

	DSP Resources

	Connecting to the ControlSpace ESP-88 system
	Go on-line
	Uploading to the ESP-88
	Real-time controls
	Downloading settings: connecting to an existing ControlSpace ESP-88 system

	Go off-line


	Chapter 4 : Store system programming
	Groups
	Parameter Sets
	Creating parameter sets
	Parameter Set Nodes List
	Storing discrete parameters

	Changing values in parameter sets
	Recalling parameter sets
	Clearing parameter sets

	Presets
	Creating presets
	Recalling presets
	Changing presets
	Clearing presets

	Timers
	Creating timers
	Timer Setup
	Recalling timers
	Clearing timers

	Using the Project Directory

	Chapter 5 : Program user controls: CC-64 and CC-16
	Programming overview
	CC-64 Control Center
	CC-64 Smart Simulator
	Programming the CC-64
	Custom settings
	Control Properties
	Locking the CC-64

	CC-64 Properties

	CC-16 Zone Controller
	CC-16 Smart Simulator
	Programming the CC-16
	Volume control button properties
	Locking the CC-16

	CC-16 Properties


	Chapter 6 : Program GPI/O and Serial Input/Output
	General Purpose Inputs (GPI)
	Operating modes
	Programming GPI
	Invoking signal processing blocks using a GPI
	Invoking a parameter set
	Invoking a preset
	Controlling a group
	Discrete mode
	Using a potentiometer
	Using up and down buttons for volume control
	Testing GPI


	General Purpose Outputs (GPO)
	Programming GPO

	Serial Inputs
	Serial Outputs
	Using the Project Directory

	Chapter 7 : Signal Processing (SP) Tool Kit reference
	Crossovers
	2 way crossover
	Type
	Frequency
	Polarity
	Mute
	Link

	3 way crossover
	Link

	4 way crossover
	The top section of the control panel is a graphical representation of the crossover settings. The line to the left represents th...
	Link


	1/3 Oct Graphic EQ
	Tone control EQ
	Parametric EQ
	Type
	Frequency
	Q or BW
	Gain
	Bypass
	Sort
	Storing and saving equalization settings

	Speaker EQ
	Single Speaker
	Crossover + Speaker EQ
	2 Bass Array
	4 Bass Array

	Routers
	Gain
	Delay
	Standard Mixer
	Matrix mixer
	Room Combining Mixer
	Combining rooms

	Signal Generator
	Sine wave generator
	Noise generator
	Sweep generator

	Meters
	Compressor/Limiter
	Duckers
	AGC
	Gate
	Source Selector

	Chapter 8 : Menu and Toolbar reference
	Menu reference
	File menu
	Edit menu
	View menu
	Tools menu
	System menu
	Window menu
	Help menu

	Toolbar reference
	Main toolbar


	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	W
	Numerics



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


